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Predgovor

Drage kolegice in kolegi,

letošnja IKTEM konferenca je nekaj posebnega. Ne samo zaradi okrogle 
letnice (2020), pač pa - kot vsi veste, zaradi Covid-19 situacije, ki nam je 
preprečila izvedbo konference v klasični obliki s predavanji, praktičnimi 
delavnicami ter prijetnim druženjem. 

Že v času karantene smo pogledovali številke okuženih za Covid-19, iz 
česar smo upali, da bomo konferenco v klasični obliki lahko organizi-
rali. V začetku maja je bila situacija še precej negotova glede druženja 
večjih skupin ljudi in predvsem odpiranja turističnih lokacij. Ker je nego-
tova situacija vztrajala, smo se s težkim srcem odločili, da IKTEM 2020 
izpeljemo v obliki Zbornika predavanj, ki ga bodo prejeli vsi prijavljeni. Poleg tega bosta Zbornik predavanj 
IKTEM 2020 reviji Svet elektronike in Svet mehatronike razposlali vsaka po svoji bazi kontaktov.

Tudi letos smo, tako kot v preteklih letih, na enem mestu zbrali veliko zanimivih predavanj s področij IKT, 
elektronike in mehatronike. 

Predavanja so v slovenskem in angleškem jeziku in obsegajo področja, ki so zanimiva tako za vodstveni 
kader, kot tudi za tiste, ki delate v razvoju, proizvodnji in vzdrževanju.

Na koncu uvodne besede bi se v imenu organizacijskega odbora IKTEM rad zahvalil avtorjem prispevkov 
ter seveda tudi sponzorjem, ki so IKTEM 2020 kljub težavni situaciji podprli!

AX elektronika d.o.o.
Jurij Mikeln dipl. inž.
Trzin, 18. junij 2020
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Arrow Electronics pomaga 
pri razvojnih projektih

Arrow Slovenija 
Avtor: Simon Rusjan, Direktor Arrow Slovenija 

simon.rusjan@arroweurope.com 
www.arrow.com 

Verjetno mnogi od vas poznate Arrow Electronics (v nadaljevanju Arrow) zgolj kot distributerja elektronskih 
komponent, zato sem se odločil, da vam to globalno podjetje s 85-letno tradicijo in sedežem v Centennialu 
(Kolorado), prikažem tudi v drugi luči.

Ne glede na to, da je Arrow največji svetovni distributer elektronskih komponent (to je bilo ravnokar ponovno objavljeno tudi na 
»Top 50 Electronic Component Distributors List«), se tudi mi zavedamo, da danes trg in kupci zahtevajo mnogo več, kot le dobiti 
želeno komponento na traku ali v tubi pripravljeno za uporabo v nadaljnjih procesih sestave končnega produkta. V ta namen je 
Arrow v zadnjih letih bodisi odprl nove divizije ali pod svoje okrilje spravil veliko različnih podjetij, ki danes z 19.300 zaposlenimi v 
90.-ih državah preko 336 lokacij oskrbujejo več kot 175.000 partnerjev in pri tem generirajo skoraj 30 milijard USD prometa.

Skratka, Arrow se želi danes identificirati kot Technology Solution provider in v naslednjih vrsticah bi vam rad predstavil podjetja 
ali oddelke, ki zagotavljajo, da lahko Arrow danes ponudi vse od komponente, do razvojnih modulov, softvera, programiranja, proi-
zvodnje in sestave pa  do kompletne povezave v t.i. rešitve v oblaku (Cloud Service). Prav tako smo omogočili, da te rešitve bodisi 
poiščete ali ponudite na naši novi spletni platformi ArrowPlus, o kateri si nekaj več lahko preberete v nadaljevanju.

eInfochips je znotraj Arrowa zadolženo za celovite rešitve na najvišji možni ravni. Že dejstvo, 
da nam zaupa veliko podjetij iz lestvice Fortune 500 govori v prid temu, da lahko 1.700 inženir-
jev pripravi za vas kompletno rešitev od idejne zasnove do končnega razvoja in organiziranja 
proizvodnje. S svojimi referencami se lahko pohvalijo praktično v vseh segmentih, vključujoč 
avtomobilsko, letalsko, medicinsko... industrijo, do novodobnih rešitev na področju pametnih 
hiš, zgradb, mest... Kratek predstavitveni video lahko najdete na tej povezavi: https://www.
youtube.com/watch?v=4DHkl-dy52w&feature=emb_logo 

ESC – Engineering Services Center je oddelek, ki za vas vas pripravlja najnovejše razvojne module (development boards) skupaj 
z največjimi svetovnimi tehnološkimi giganti. Izbira le-teh vam omogoča predvsem veliko hitrejši »time to market«, saj ne izgub-
ljate dragocenega časa s kompleksnim razvojem in pogosto dragim certificiranjem. Hkrati pa (podobno kot eInfochips, vendar na 
manjših projektih), lahko zagotovijo tudi kompleten razvoj HW-a (skupaj z optimiziranim BOM-om), SW-a, povezave v Cloud rešitve 
– skratka, so naš IoT oddelek na najvišjem nivoju, močno podprt tudi s sodelovanjem lokalnih Arrow Field Application Engineer-jev 
(FAE). Več na: https://www.arrow.com/en/iot 

ArrowPlus – Powered by Freelancer - je platforma, ki je narejena s strani inženirjev in za inženirje. V 
kolikor iščete posebno znanje ali morda zaradi pomanjkanja kapacitet ne morete sami pravočasno 
zagotoviti razvoja, lahko pomoč poiščete na enem mestu, ki združuje znanje preko 500.000 ljudi iz 
celega sveta. Prav tako lahko svoje znanje ali razvojne zmogljivosti ponudite tudi sami. Postopek 
je preprost - predložite opis projekta, prejmite ponudbe, izberite inženirja in začnite z delom. Kako 
najti rešitev za svoj problem v 24.-ih urah ter povsem transparentno ter zaupanja vredno, si lahko 
ogledate na tem kratkem predstavitvenem videu: https://vimeo.com/323866681 

Arrow.com je naš novodobni spletni prodajalec, ki je vse bolj stalnica v tem sodobnem svetu. Eki-
pa sodelavcev po celem svetu skrbi, da lahko vedno zagotovimo najugodnejšo ponudbo iskane 
komponente na svetu in vam jo odpremimo še isti dan po kliku na spletni prodajalni. Prav tako 
vam omogočimo, da lahko svoj BOM naložite direktno na splet in v nekaj minutah dobite stroškov-
no oceno za vaš izdelek, hkrati pa vam bo najzmogljivešjo orodje SiliconExpert v ozadju preverilo, 
ali ste izbrali prave komponente, ki bodo dobavljive tudi v naslednjih letih in vam hkrati priporoča 
alternative. Dodatno lahko svojo poizvedbo preverite na portalu Verical, ki je največja svetovna platforma za iskanje elektronskih 
komponent po celem svetu. Še vedno pa velja, da je vsaka komponenta ne glede na njen izvor preverjena po najvišjih standardih 
Arrowa, ki tudi zagotavlja ustreznost.

mailto:Simon.Rusjan@arroweurope.com
http://www.arrow.com/
https://www.arrow.com/
https://www.einfochips.com/
https://www.youtube.com/watch?v=4DHkl-dy52w&feature=emb_logo
https://www.youtube.com/watch?v=4DHkl-dy52w&feature=emb_logo
https://www.arrow.com/en/iot
https://www.arrow.com/en/iot
https://www.arrow.com/en/plus/freelancer
https://vimeo.com/323866681
https://www.arrow.com/
https://www.siliconexpert.com/
https://www.verical.com/
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Arrow’s Enterprise Computing Solutions Business je oddelek, ki lahko za vas pripravi celovito ponudbo na področju IT infrastruk-
ture, od enostavne računalniške opreme do kompleksnih strežniških rešitev, hkrati pa je tudi certificirano za izobraževanje o pro-
gramih in uporabi različnih tehnoloških gigantov, kot so IBM, Citrix, Veeam, VMware in Java. Skratka, v kolikor potrebujete rešitve 
na ključ tudi na IKT področju, bodo kolegi iz oddelka z veseljem prisluhnili vašim zahtevam.

Indiegogo je pravi naslov za vse start-upe ali podjetja, ki želijo uresničiti svoj novi projekt preko te 
svetovne platforme. Bodisi, da rabite tehnološko pomoč ali želite poiskati finančne vlagatelje, je 
lahko ta Arrow certificirani program pravi naslov za vaš problem. V zadnjih letih smo preko tega pro-
grama uspešno zaključili veliko število projektov, prav tako smo s pomočjo naših inženirjev podprli 
prenekateri start-up projekt. Več v predstavitvenem videu: https://vimeo.com/281871419 

Dejstvo je, da se današnji razvoj odvija z neprimerno večjo hitrostjo, kot je bilo to še pred nedavnim. 
Prav tako je neizpodbitno, da so pojmi kot so umetna inteligenca (AI) ter IoT vse večji del našega 
vsakdana in včasih tudi sami težko sledimo temu tempu oziroma v danem trenutku nimamo pri roki 
pravega znanja ali rešitve. Prav zato je Arrow vaš pravi partner tudi na projektih, ki vam bodo poma-
gali, da boste lažje premagovali tovrstne izzive in se hkrati fokusirali na svojo primarno dejavnost, 
kjer ste najmočnejši. 

Z veseljem vam vse podrobnosti o zgoraj opisanih programih predstavimo tudi podrobneje, zato kontaktirajte Arrow še danes.

https://www.arrow.com/ecs/na
https://www.arrow.com/en/indiegogo
https://vimeo.com/281871419
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Silicon Labs delivers 
a family of small, 

Low-Power Bluetooth 5.2 
SoC optimized for high 

volume production
Arrow Slovenija 

Avtor: Tin Vukadinovic 
www.arrow.com 
www.silabs.com

The EFR32BG22 (BG22) Wireless Gecko family of Bluetooth 5.2 SoC devices deliver the right combination 
of security features, processing power, wireless performance and software to meet the market demand for 
high-volume, battery powered IoT products.

 
Based on Silicon Labs’ secure, ultra-low-power Wireless Gecko Series 2 platform, BG22 SoCs provide developers with a versatile, 
scalable connectivity solution supporting the new Bluetooth 5.2 specification, Bluetooth mesh 1.0, angle-of-arrival.

Applications
• Asset tags and beacons
• Portable medical
• Bluetooth mesh low-power nodes
• Sports, fitness, and wellness devices
• Connected homes end devices
• Building automation and security
• Consumer electronics remote controls

Supports Bluetooth 5.1, 5.2 & Bluetooth Mesh, Ideal for ultra-low-power battery-powered IoT devices with Security features 
https://www.arrow.com/en/research-and-events/articles/low-cost-secure-bluetooth-socs

http://www.arrow.com/
https://www.arrow.com/en/research-and-events/articles/low-cost-secure-bluetooth-socs
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https://www.arrow.com/en/research-and-events/videos/silicon-labs-thunderboard-efr32bg22

For more information on Silicon Labs products (also demo boards and samples) please contact Arrow Slovenia (tin.vukadinovic@
arrow.com)

https://www.arrow.com/en/research-and-events/videos/silicon-labs-thunderboard-efr32bg22
mailto:tin.vukadinovic@arrow.com
mailto:tin.vukadinovic@arrow.com


Arrow electronics

 Največji distributer elektronskih komponent na svetu

 Fortune 110 podjetje, 19.300 zaposlenih na 336 lokacijah po celem svetu

 eInfochips – 1.700 inženirjev pripravi za vas kompletno rešitev 

 od idejne zasnove do končnega razvoja in organiziranja proizvodnje

 Engineering Services Center (ESC) – razvije za vas najnovejše razvojne module, 

 pripravljene za integracijo v vaš produkt

 SiliconExpert – največja svetovna baza podatkov za elektronske komponente

 ArrowPlus – 500.000 inženirjev na enem mestu ponuja svoje storitve na vseh področjih

 Arrow.com – najugodnejši spletni ponudnik elektronskih komponent

 Verical – največji elektronski market za ponudbo in iskanje elektronskih komponent

 Converge – Avtorizirani Arrow partner, ki poskrbi za celovito dobavo komponent 

 tudi po preteku življenjske dobele-teh

 Transim – orodje za “on-line” pomoč inženirjem pri načrtovanju elektronskih vezij 

 in ostalih tehnoloških rešitev

Arrow electronics d.o.o.
Ukmarjeva ulica 2

1000 Ljubljana
simon.rusjan@arroweurope.com

+386 1 420 13 83www.arrow.com
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PRINCIPLES OF 5G
Connect the Unconnected Things! 

As we claimed in our booklet, 5G will have profound impact on the course of human civilization. Mobile subscribers would benefit 
from 5G in different ways which can be summarized as better User Experiences. However, the greater impact is on Machines, to 
make the world highly connected and ultra-smart. The foundation for such transformation will be 5G.

5G-IoT, Applications 
and Use Cases

Quectel Wireless
support@quecte.com

www.quectel.com

As we explained earlier, 5G mostly targets IoT as new market segment. Figure 14 divides 5G use cases into 
3 areas, known as eMBB, URLLC and FWA use cases. For instance, AR/VR requires both high bandwidths 
and extremely low latency, while most of automotive use cases only require low latency and high reliability. 

Depending upon use cases, MNOs will define Service Level Agreement (SLA). It’s quite evident that they will charge IoT customers 
based on adopted SLA. Hence it will be increasingly important for IoT solution providers to define their equipment into an 
appropriate circular. 

Fixed Wireless Access
A very real use case of 5G is to provide higher data bit rate to fixed subscribers. Mobile technology is considered as true murderer 
of fixed network, since 2G and LTE have been defeating landline and ADSL/VDSL respectively. It’s now 5G’s turn to omit the 

Use Case Clustering in 5G (Source: GSMA)
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need for FTTH (Fiber to the Home) even before 
the industry gives birth to it. The trend is obvious: 
Home and Industrial Getaway and 5G Routers are 
among pioneering products to hit the market which 
consume bandwidth supposed to be provided by 
the Fiber.

Consumer Laptop and 
Industrial Tablet
Always Connected PCs (ACPC) is getting popularity. 
This trend will be further strengthened by 5G. True 
virtual offices which allow people to conduct 
almost all office tasks remotely are becoming part 
of today’s business habits. Offices will be gradually 
moving back to homes as they are supported 
with many other sophisticated features, just to 
name a few, 4K-Video conference call, document 
sharing, Cloud based ERP, real time translator 
assistance, robotics, etc. This makes life more 
joyful and decreases transport cost, traffic jam, fuel 
consumption and the need for bigger office space. 

Augmented and Virtual 
Reality (AR/VR)
In the most advanced countries, today’s digital 
consumers (using PCs and smartphones) will likely become tomorrow’s augmented customers, adopting emerging technologies 
such as AI (via smart speakers) and immersive reality. 

Fixed Wireless Access, Gateway/Router/CPE

Connected PC 

Augmented and Virtual Reality
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Mobile users will enjoy the next generation 
of connected immersive experiences as 
AR/VR mainly target entertainment market 
segment. Nevertheless, AR/VR have also 
become an undoubted part of digital 
economy and are transforming, for instance, 
how engineers design new products. You 
may also imagine a team of doctors conduct 
a surgery collaboratively by controlling 
robots remotely using AR/VR.

Drones
The Three-Dimensional Transportation 
(3DT) era will be coming within next decade. 
The human evolution had commenced with 
1D transportation when mankind could 
stand up on his/her feet and start walking. 
The 2D transportation arena started with 
domestication of horses and continued 
by invention of trains and cars. Airplanes, 
copters and even spaceships cannot be 
considered as true 3D transport machines 
but rather 2.5D. 

Drones are machines that can freely fly in three dimensions. However, in order to legally, technically and affordably become widely 
available, they need to address certain challenges. Drones are poised to be highly connected and intelligent for collision avoidance 
as well as prevention of entering restricted areas. Therefore, they should be equipped with ultra-sophisticated auto pilot system, 
which cannot be economically and commercially viable unless it’s always connected to the cloud. 5G would be the excellent 
choice for its communication backbone to satisfy technical needs of the pipe in a cloud-based auto pilot system. 

C-V2X
Cellular Vehicle-to-Everything (C-V2X) is an obvious use case of 5G as always-connected car and autonomous vehicle need high 

 Drone

C-V2X
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speed and low latency backbone to be realized. The new radio interface provides ability for higher level of predictability. 
C-V2X immediately offers a robust platform to provide the vehicle with enhanced situation awareness. In contrast, the older 
DSRC/IEEE 802.11p capability will rely on the deployment of new, dedicated DSRC-capable infrastructure along roadways, which 
has proven not to be easily scalable and even after 15 years of its invention is yet to become a main stream of ITS industry. 

This is clear that due to advancements in autonomous diving and commercialization of its level-1 and level-2, the car OEMs are 
poised to accelerate C-V2X projects more aggressively. The competition to create the best driverless car has never been hotter 
and it will be further fueled by the 5G rollout. 

Author predicates that by 2030 a connected/autonomous/AI driver can win formula-1 car race, if allowed to be a participant. 

Needless to add that the 5G will be going to offer more facilities for the connected vehicles as it can provide in-vehicle entertainment, 
makes journey even more pleasant. 

Other Verticals/Use Cases
There might be countless new Use Case that can leverage 5G value proposition such as 5G-TV, setup box, robots, car sharing, 
a wider range of asset sharing, high-end surveillance systems, in-vehicle surveillance camera, smart factory, to name a few. 
Figure-24 depicts how high speed and low latency can enable new use cases.

5G Use Cases
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NB-IoT kot nadomestna 
tehnologija za GPRS 

A1 Slovenija d. d., Ljubljana
Božo Mišović EIMV

Marjana Senčar Srdič

V članku je poudarek na konkretnih izkušnjah/meritvah posameznih LTE -M/LTE NB-IoT modemskih naprav, 
posebej s stališča prevzema LTE NB-IoT, ki naj bi zamenjala stare GPRS industrijske komunikacijske 
vmesnike (pričakovana možna ukinitev v Sloveniji leta 2029).

V podporo nadaljne širitve in razvoja Internet 
of Things/Interneta Stvari (IoT), je mobilna 
industrija razvila in standardizirala klase 
namenskih mobilnih-celičnih tehnologij. Takšna 
mobilna IoT omrežja podpirajo naprave, ki 
zahtevajo širokopasovno pokrivanje, dolgo 
življenjsko dobo baterij in nizke cene, s 
poudarkom na varnosti in povezljivosti tako za 
zunaj mestna, kot za mestna področja. 

Glede na izkušnje 24 mobilnih operaterjev, ta 
povzetek opisuje kako so se LTE-M in NB-IoT 
omrežja  začela uveljavljati po svetu, kaj so se 
mobilni operaterji in njihovi partnerji že morali 
naučiti in kaj načrtujejo v prihodnje. Pojasnjeno je 
tudi, kako so v mobilni IoT ovrednotili postavitev 
komercialnih parametrov, kot povzetek prvotnih 
planov ter razpoložljivosti modelov, »chipsetov« 
in drugih naprav.

V prispevku so podane značilnosti bodočih 
LTE-M in NB-IoT naprav, ki so že standardizirane 
v 3GPP-3rdGenerationPartnershipProject’s za uporabo v licenčnih spektrih. Obe omenjeni tehnologijista omogočili mobilnim 
operaterjem, da so lahko pokrili široko paleto uporabniških primerov, z zagotavljanjem uporabniških zahtev za globalno podporo 
mobilnih IoT.

LTE-M je poenostavljen naziv za eMTC (enhanced Machine-Type Communication) LPWA (Low Power Wide Area) tehnologijo, ki 
je standardizirana v specifikaciji 3GPP, Release 13. Bolj natančno je specificirana kot LTE CatM1 tehnologija, ki je načrtovana za 
podporo IoT. LTE-M je široko-prostorna (LPWA) tehnologija majhnih moči, majhne kompleksnosti in podaljšanega pokrivanja, 
glede na LTE klasično pokrivanje, ki deluje na obstoječih LTE baznih postajah

Long Term Evolution for Machines: LTE-M
Opisana tehnologija lahko omogoča delovanje naprav z življenjsko dobo baterij do 10 let v 
raznolikih primerih uporabe, ki ceno modema zmanjša do 20-25% glede na klasične EGPRS 
modeme. LTE-M lahko tudi podpira relativno hitre prenose, mobilnost, gostovanje (roaming) 
in VoIP/VoLTE storitve.

LTE Cat-M1, je hitrejši, sistem majhne porabe, ki omogoča prenos hitrosti v smeri prenosa »navzgor/«upload«,do 367Kbps, majhnih 
kasnitev, primeren za vsak primer IoT uporabe, vključno s smart meteringom/pametni števci, kot tudi za prenos govora, mobilnosti 
in roaminga/potepanja, možnost nadzora, upravljanja voznega parka in varnosti na domu

LTE-M omrežja so podprta v večini mobilnih naprav; tovarniško podprti »chipseti« in moduli so podprti v 2G, 3G in 4G javnih 
mobilnih omrežjih.Tehnologija vsebuje ustrezne varnostne mehanizme ter lastnosti značilne za mobilna omrežja, kot so podpora 
zaupnosti uporabniške identitete, subjektne avtentifikacije, integriteto podatkov in identifikacijo mobilnih naprav, uporabnih v 
javnih službah, prenosih in industriji. Komercialno naj bi bila LTE-M omrežja omogočena že v tem obdobju.
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Narrow Band – Internet of Things (NB-IoT)
“NarrowBand” IoT (NB-IoT) je standardiziran v 3GPP.Gre za naprave majhnih moči, LPWA 
tehnologijo, ki omogoča široko razprostrto pokrivanje za nove IoT naprave in storitve. NB-
IoT minimizira porabo povezanih naprav, povečuje sistemsko kapaciteto in spektralno 
učinkovitost, še posebej na lokacijah, ki omogočajo pokritost mobilnim celičnim tehnologijami. 
NB-IoT povezljive naprave ohranjajo v širokem spektru uporabe življenjsko dobo baterij tudi več kot 10 let.

NB-IoT uporablja novi fizični nivo s signali in kanali, ki lahko demantirajo zahteve širokega pokrivanja ruralnih področji, ter globino 
pokrivanja znotraj objektov, z uporabo zelo majhne kompleksnosti naprav. Tehnološka kompleksnost naprav je veliko bolj 
enostavna, glede na obstoječe GSM/GPRS module, kar zelo zmanjša ceno NB-IoT modulov. Glede na povečan interes se cena 
hitro zmanjšuje.

NB-IoT Cat-NB1ponuja povprečen hitrostni razred v 
smeri prenosa »navzgor/«upload«, med 20-65Kbps, 
v piku celo do 256Kbps. NB-IoT je limitiran na 
uporabo SMS, notranjega roaminga/potepanja in ne 
podpira govora.

Tehnologija NB-IoT je podprta večinoma v vseh 
mobilnih napravah, ki podpirajo mobilna omrežja 2G, 
3G in 4G, kot tudi bodoča 5G, s nadgradnjo v Rel 17 
(po letu 2021). Podprta jez ustreznimi varnostnimi 
mehanizmi ter lastnostmi značilnimi za mobilna 
omrežja, kot so podpora zaupnosti uporabniške 
identitete, subjekte avtentifikacije, integriteta 
podatkov in identifikacija mobilnih naprav, uporabnih 
npr. v aplikacijah za »pametno« parkiranje, javnih 
službah, prenosih in industriji. Komercialno, so bila 
NB-IoT omrežja omogočena že v letu 2017/18.

Vsaka od tehnologij ima seveda svoje slabosti in prednosti. NB-IoT podpira nižje hitrosti podatkov, ter ni namenjena za podporo 
WEB aplikacij, PPP ali celo TSP načina izmenjave podatkov.

NB-IoT tehnologija je zamišljena za UDP potiskanje(push) podatkov iz smeri senzorjev proti strežnikom, za katero ni potrebe 
po konstantni komunikaciji (recimo PPP). Narejena je tudi, da varuje življenjsko dobo baterij (po potrebi občasna komunikacija/
večinoma v »spanju«), sinhronizacija s omrežjem je reducirana, kar povzroča večje kasnitve.

NB-IoT je tehnologija, ki je dizajnirana za uspešno dostavo določenih manjših količin znakov (»bytes«), večkratnih ponovitev in 

Izmerjeni rezultati
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večkratnega pošiljanja, glede na vsaj 1 krat korektno zahtevo iz strežnika. Vsebuje prednosti pri dostavi podatkov dolgih razdaljah, 
v slabih pogojih sprejemnega signala, ter ponuja nižje propustnosti »navzdol«/download

LTE NB-IoTje ustrezno nadomestno brezžično komunikacijsko DATA  omrežje,  ki lahko nadomesti GPRS!

Ključnebesede — 2G/3G/4G/5G, eMTC(enhanced Machine-Type Communication), LPWA (Low Power Wide Area), Long Term 
Evolution for Machines: LTE-M, Narrow Band – Internet of Things (NB-IoT), 3GPP-3rd Generation Partnership Project’s,   3GPP/ 
Release 13 specifikacija

Božo Mišović
ELEKTROINŠTITUT MILAN VIDMAR inštitut za elektrogospodarstvo in elektroindustrijo, zunanji 
svetovalec
Rojen v Ljubljani leta 1952. Fakulteto za elektrotehniko v Ljubljani, smer Telekomunikacije, je končal 
leta 1977. Prvo delovno razmerje je nastopil v ISKRA Elektrozveze, v letu 1976, na področju domače 
proizvodnje naprav za podatkovni prenos-modemi - za obdobje desetih letih. V času tržne transformacije 
podjetij, za čas dveh let, je pomagal pri ustanovitvi podjetja SMARTCOM, delal kot tehnični direktor 
in nadaljeval deset let v podjetju SRC.SI kot vodja programa za WAN komunikacije. Nato je delal v 
MOBITELu kot tehnični strokovnjak na uvajanju GPRS/UMTS/HSPA/LTE za končne uporabnike. 2015 je 
zaključil delo v Telekom. Sedaj dela kot zunanji svetovalec na EIMV. Božo je aktiven tudi kot predavatelj 
na številnih dogodkih s področja podatkovnih komunikacij. 

Marjana Senčar Srdič
A1 SLOVENIJA d. d., Vodja tehnologij interneta stvari in inovacij
Rojena v Celju leta 1976. Ekonomsko – poslovno fakulteto, smer Zunanja trgovina je zaključila leta 2001. 
Študij je nadaljevala na podiplomski stopnji in v letu 2016 zaključila magistrski študij managementa. 
Od leta 2001 je pridobivala delovne izkušnje na področju informacijsko telekomunikacijskih tehnologij, 
tako v manjših, kot velikih, mednarodnih podjetjih (nekdanji Hermes SoftLab, Hewlett Packard). V 
okviru A1 Slovenija je že nekaj let vključena v raziskovalno – inovacijske projekte in uvajanje novih 
tehnologij (NB-IoT, LTE-M, 5G in povezane rešitve in storitve). Je registrirana raziskovalka pri Agenciji 
za raziskovalno dejavnost RS (ARRS), aktivna v raziskovalni organizaciji, vodi vertikalo Mobilnost, 
transport in logistika v okviru SRIP Pmis.



Z rešitvijo pomagamo izboljšati kakovost bivanja 
prebivalcev, spodbujamo trajnostni razvoj, 
znižujemo obratovalne stroške ter učinkovito 
obvladujemo vplive na okolje.

Za več informacij o rešitvi A1 Pametno 
mesto pokličite na 040 440 329 ali nam 
pošljite povpraševanje na: dti@A1.si.

Rešitev A1 Pametno mesto. 
Na voljo že danes za boljšo 
prihodnost slovenskih mest.

• Spremljanje okolja z 
nadzornimi postajami, 
ki merijo specifične 
koncentracije plina in 
delcev.

• Pametni promet z video  
viri v realnem času analizira 
promet in šteje vozila v 
prometnih tokovih. 

• Upravljanje z odpadki s 
senzorji, ki merijo raven 
napolnjenosti zabojnikov za 
odpadke.

• Pametna razsvetljava 
z radarskim senzorjem 
najbolj optimalno 
razsvetljuje javne 
površine. 

• Pametno parkiranje s 
senzorji, ki ugotavljajo 
zasedenost posameznih 
parkirnih mest.

Ter številne druge 
rešitve za boljše mesto in 
zadovoljne prebivalce.
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NB-IoT as a replacement
technology for GPRS

A1 Slovenija d. d., Ljubljana
Božo Mišović EIMV

Marjana Senčar Srdič

Following text  will  introduce concrete measurement experiences at individual new cases of LTE technologies 
as LTE-M1 and NB-IoT, where actually NB-IoT, should be, considered as proper candidate, to replace existing 
older GPRS public wireless technology in near future (probably switch off in Slovenia will be carried out 
inyear 2029 ).

To support the further expansion and evolution of 
the Internet of Things (IoT), the mobile industry has 
developed and standardized a class of dedicated cellular 
technologies. These mobile IoT networks support 
devices requiring broad coverage, a long battery life and 
low cost, yet secure, connectivity across both rural and 
urban locations.

Drawing on interviews with 24 mobile operators, this 
report outlines how LTE-M and NB-IoT networks are 
being rolled out around the world, what operators and 
their partners have learnt so far and what they plan to 
do next. It explains how the Mobile IoT is creating value 
in commercial settings, while outlining initial tariff plans 
and the availability of modules, chipsets and other 
equipment.
The article also provides an overview of the features of 
LTE-M and NB-IoT, which have been standardized by the 
3rd Generation Partnership Project’s (3GPP) for use in 
licensed spectrum. Together, these technologies are enabling mobile operators to address a very wide range of potential use 
cases, ensuring customer choice and helping the IoT to flourish globally.

LTE-M is the simplified industry term for the eMTC LPWA technology, which was standardized by 3GPP in the Release 13 
specification. It specifically refers to LTE CatM1, which is designed to support the IoT. LTE-M is a low power wide area (LPWA) 
technology, providing low device complexity and extended coverage, while allowing the reuse of existing LTE base stations.

Long Term Evolution for Machines: LTE-M
The technology can allow connected devices to have a battery lifetime of at least 10 years 
for a wide range of use cases, with the modem costs reduced to 20-25% of the current 
EGPRS modems. LTE-M also supports relatively fast data throughput, mobility, roaming and 
potentially voice services.

Supported by all major mobile equipment, chipset and module manufacturers, LTE-M networks will co-exist with 2G, 3G, and 
4G mobile networks and benefit from all the security and privacy features of mobile networks, such as support for user identity 
confidentiality, entity authentication, data integrity, and mobile equipment identification. Commercial launches of LTE-M networks 
are now underway.

NarrowBand – Internet of Things (NB-IoT)
NarrowBand-Internet of Things (NB-IoT) is a standards-based low power wide area (LPWA) 
technology developed to enable a wide range of new IoT devices and services. NB-IoT 
significantly improves the power consumption of user devices, system capacity and spectrum 
efficiency, especially in deep coverage. Battery life of more than 10 years can be supported 
for a wide range of use cases.
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New physical layer signals and channels are 
designed to meet the demanding requirement of 
extended coverage – rural and deep indoors – and 
ultra-low device complexity. Initial cost of the NB-
IoT modules is expected to be comparable to GSM/
GPRS. The underlying technology is however much 
simpler than today’s GSM/GPRS and its cost is 
expected to decrease rapidly as demand increases.

Supported by all major mobile equipment, chipset 
and module manufacturers, NB-IoT can co-exist 
with 2G, 3G, and 4G mobile networks. It also 
benefits from all the security and privacy features of 
mobile networks, such as support for user identity 
confidentiality, entity authentication, confidentiality, 
data integrity, and mobile equipment identification. 
The first NB-IoT commercial launches have been 
completed and global roll followed in 2017/18.

Each technology has its advantages and disadvantages. NB-IoT has lower data rate, it's not meant for web browsing, PPP or not 
even for TCP.

NB-IoT is meant for UDP data push from sensor to server, with no permanent connection (like PPP) and to save battery life, sync 
with network is reduced, so the bigger latency.

NB-IoT is designed to successfullydeliver couple of bytes of useful data, repeating and re-transmitting it many times so at least 
1 request is received by the server correctly, having advantage of longer reach in bad signal conditions and downside of lower 
throughput. 

Many factors impact the network coverage e.g. where is the cell/cell quality level etc.Based on the research and simulation result, 
NB-IoT coverage will be 4 times of GSM/LTE, and Cat-M1 will 3 times. 

Therefore3GPP developed CatNB (NBIoT) and LTE M (CatM1) can to replace GPRS. 

Keywords — 2G/3G/4G/5G,  eMTC(enhanced Machine-Type Communication), LPWA (Low Power Wide Area), Long Term 
Evolution for Machines: LTE-M, Narrow Band – Internet of Things (NB-IoT), 3GPP-3rd Generation Partnership Project’s,   3GPP/ 
Release 13 specification.

Measured results
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Božo Mišović
ELEKTROINŠTITUT MILAN VIDMAR Institute of Electrical Engineering and Electrical Industry, external 
consultant
Bozo Misovic, was born in Ljubljana in1952. He graduated in 1977, from the Ljubljana University, 
Slovenia – Faculty of Electrical Engineering in the filed of Telecommunications. He started first job at the 
electronic manufacturing company ISKRA Elektrozveze in 1976, working on data modems productions 
and customer supports! After 10-years he establish new electronic company SMARTCOM, representing 
Motorola, RAD, TADIRAN and others communications companies where he worked as technical director! 
In the year 1992, he started working in company SRC.SI as WAN support manager using Novel, Microsoft 
and Cisco environment! In the year 2001 Božo started working in the mobile operator MOBITEL at GPRS/
UMTS/HSPA/LTE support! Last employment was at Telekom Slovenija. After retirement in 2015 he has 
joined EIMV research institute as External Associate for Mobile Networks. As lecturerhe has been giving 
many presentations in and out of Slovenia!  

Marjana Senčar Srdič
A1 SLOVENIJA d. d., Head of Internet of Things and Innovation Technologies
Born in Celje in 1976. She graduated from the Faculty of Economics and Business, majoring in Foreign 
Trade in 2001. She continued her studies at the post graduate level and in 2016 completed a master's 
degree in management. Since 2001, she has gained work experience in the field of informationand 
telecommunications technologies, in both small and large, international companies (former Hermes 
SoftLab, Hewlett Packard). Within A1 Slovenia, she has been involved in research and innovation 
projects and roll-out of new technologies for several years (NB-IoT, LTE-M, 5G and related solutions 
and services). She is a registered researcher at the Research Agency of the Republic of Slovenia 
(ARRS), active in a research organization and leads the Mobility, Transport and Logistics vertical 
within SRIP Pmis.
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Nov pristop k izdelavi 
medicinskih pripomočkov 

s tehnologijo HP 
Multi Jet Fusion

CGS plus d.o.o.
Po virih HP povzela: Edita Žugelj

https://www.cgsplus.si

HP je prvi 3D-tiskalnik, ki deluje s tehnologijo Multi Jet Fusion, predstavil leta 2017. Edinstvena HP-jeva teh-
nologija za razliko od drugih, ki uporabljajo postopke s počasnim ustvarjanjem točk, enote obdela s hitrimi 
prehodi čez celotno tiskalno območje in s tem doseže veliko proizvodno hitrost. 

Podjetje CGS plus je edini slovenski ponudnik in serviser za 3D-tiskalnike HP Multi Jet Fusion. V študiji vam predstavljamo, kako 
so v italijanskem podjetju Everex nekatere obstoječe proizvodne procese nadomestili s tehnologijo HP Multi Jet Fusion, rezultat 
pa so medicinski pripomočki z manj komponentami, ki izpolnjujejo zahteve kupcev po manjši teži in nižjih stroških izdelave.

Everex je visokotehnološko podjetje s sedežem v italijanskem mestu Sesto Fiorentino, ki je zadnjih 30 let posvetilo ustvarjanju 
edinstvenih in tehnično naprednih izdelkov za potrebe svojih kupcev v zdravstvenem sektorju. Specializirano je za proizvodnjo in-
strumentov za in-vitro diagnostične pre-
iskave (IVD) po konceptih in zasnovah, 
ki jih pripravijo kupci. Kupci sicer imajo 
svoje zamisli, pogosto pa jim manjka 
potrebnih notranjih virov za njihovo rea-
lizacijo. Zato se zanašajo na Everex kot 
na partnerja, ki lahko pregleda in oceni 
predloge, razvije prototipe ter končno or-
ganizira in vodi proizvodnjo.

Pri Everexu so v 3D-tiskanju prepoznali 
jedrno tehnologijo za svoje nove izdelke, 
še posebej na področju diagnostičnih in-
strumentov.

Študija primera:
• Industrija

◊ Zdravstvo
• Sektor

◊ Medicinski pripomočki
• Cilj 

◊ Zamenjava tradicionalnih proizvo-
dnih postopkov s tehnologijo HP 
Multi Jet Fusion pri izdelavi proto-
tipov novih zasnov in združevanju 
sestavnih delov.

• Pristop
◊ Everexovi inženirji so na osnovi 

tehnologije HP Multi Jet Fusion in 
rešitev za 3D-tisk HP Jet Fusion 
oblikovali nove načine za konstru-
iranje medicinskih pripomočkov z 
manj deli, s tem pa se je zmanjša- Fotografije: Everex s�r�l�
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la teža izdelkov, znižali so se proizvodni stroški in zmanjšala se je zasedenost skladišča.
• Tehnologija | Rešitev

◊ Rešitve za 3D-tisk HP Jet Fusion, tehnologija HP Multi Jet Fusion
• Material

◊ HP 3D High Reusability (HR) PA 12 z visoko stopnjo recikliranja. 

Rešitve za 3D-tisk HP Jet Fusion, ki uporabljajo material HP 3D HR PA 12 z visoko stopnjo recikliranja, zagotavljajo do 80-odstotno 
stopnjo recikliranja prahu in proizvajajo funkcionalne izdelke od serije do serije. Material je med testiranjem staran v realnih delov-
nih pogojih in zagotovljeno je sledenje prahu po generacijah (najmanj ugoden scenarij pri recikliranju). Iz vsake generacije prahu 
naredijo izdelke, ki jih nato preizkusijo glede mehanskih lastnosti in natančnosti.

Izziv
Everex in njegovi kupci ne proizvajajo izdelkov v velikih serijah, zato brizganje ni primeren izdelovalni postopek. Ko osvajajo nove 
trge, Everexovi kupci pogosto naročajo tudi prilagoditve delov določenih instrumentov. Da bi se lahko še naprej odzivali na želje in 
potrebe svojih kupcev, so pri Everexu začeli raziskovati možnosti uporabe tehnologije 3D-tiska. 

S tehnologijo HP Multi Jet Fusion (MJF) so se prvič seznanili julija 2017 na predstavitvi programske opreme za CAD. Predstavnika 
podjetja Everex je zanimalo, kakšen potencial bi imela tehnologija MJF pri prehodu od izdelave prototipov na serijsko proizvodnjo 
s ciljem skrajšanja časa prihoda izdelkov na trg ter možnosti samostojne izdelave specifičnih delov.

Ena od Everexovih naprav je tudi Hemo One, analizator krvnih vzorcev v klinični kemiji, ki lahko odkrije različne anomalije krvi. Vse 
sestavne dele naprave Hemo One so prej izdelovali s tradicionalnimi postopki kot so rezkanje, struženje in upogibanje pločevine.
»Želeli smo zasnovati nov tip inštrumenta, ki ga bo lažje sestaviti, ki bo narejen iz manj delov in  končno tudi cenejši,« je povedal 
Massimiliano Ramalli, izkušeni inženir strojništva pri Everexu. »V tehnologiji HP MJF smo prepoznali priložnost za doseganje teh 
ciljev,« doda Ramalli. Pri Everexu so uspeli na novo konstruirati oz. predelati štiri dele naprave Hemo One: roko vzorčevalnika, dva 
pladnja za reagente in nosilec za elektroniko.

Rešitev
Podsestav roke vzorčevalnika je pritrjen na roko, ki skrbi za odmerjanje točne količine vzorca krvi za analizo in vseh potrebnih 
reagentov za različne teste. Roka vzorčevalnika, izdelana na tradicionalni način, je sestavljena iz več delov, skrbi pa za to, da so 
senzorji, vodilo igle in zunanji pokrov vedno v pravi legi. Inženirjem pri Everexu je uspelo s tehnologijo HP MJF zmanjšati število 
delov tega podsestava z od 10 do 12 na zgolj dva. Z zmanjšanjem števila delov so se poenostavili proizvodni procesi, povečala se 
je produktivnost in skrajšal se je pretočni čas v proizvodnji.

Drugi primer bistvenega zmanjšanja števila sestavnih delov s tehnologijo HP MJF, ki je nato privedlo tudi do zmanjšanja proizvo-
dnih stroškov in skrajšanja pretočnih časov, je Everexov pladenj za reagente. Gre za komponento z več prekati, ki nosi različne 
vzorce. Čeprav mora imeti pladenj za točnost meritev določeno kovinsko maso, so pri Everexu v upanju, da to ne bo vplivalo na 
točnost meritev, preizkusili možnost zamenjave kovinskega dela z delom, ki je narejen po postopku HP MJF in nato metaliziran. 

Fotografije: Everex s�r�l�
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Tako jim je uspelo izdelati ploščo, ki je za 50 % lažja in uspešno opravlja svojo funkcijo pri meritvah. Število različnih sestavnih 
delov pladnja se je zmanjšalo s 26 na samo dva.

Predelali so tudi drugi pladenj za reagente, ki je bil prej narejen iz kovinskih delov, zdaj pa ga sestavljajo samo 3D-natisnjeni deli, 
narejeni po postopku HP MJF. Everexovi inženirji so najprej začeli izdelovati prototipe različnih detajlov na krožnem pladnju z 
namero ohraniti nekatere kovinske komponente. Po koncu faze izdelave prototipov pa se je izkazalo, da je postopek HP MJF 
primeren tudi za izdelavo celega sestava. Predelani pladenj za reagente je zdaj sestavljen iz dveh koncentričnih koles. Na zunanjo 
površino notranjega dela pladnja so dodali še 24 črtnih kod za identifikacijo mest za vzorce.

Zadnji del, ki so ga pri Everexu prilagodili za izdelavo po postopku HP MJF, je bila nosilna konstrukcija za elektroniko in mehanske 
elemente naprave Hemo One. Prej so jo izdelovali z upogibanjem pločevine in je bila sestavljena iz šestih različnih elementov. Ko 
jim je uspelo izdelati nosilni sestav po postopku HP MJF, so inženirji lahko prilagodili konstrukcijo komponent in zmanjšali število 
delov na dva. Končna dela sta lažja in zato cenejša.

Rezultat
Odkar so se v podjetju Everex opremili s tehnologijo HP MJF, lahko razvijajo prototipe in končne izdelke z manj komponentami, 
razvoj pa poteka hitreje in z nižjimi stroški.

Konstruiranje modela zunanjega pokrova je prej trajalo tudi do dva meseca, s tehnologijo HP MJF pa se je ta čas skrajšal na samo 
pet dni. Obenem se je skrajšal tudi pretočni čas v proizvodnji, saj so se pri Everexu usposobili za izvedbo vseh korakov proizvodne-
ga procesa in tako odpravili čakanje na dobavitelje delov.

Z uporabo tehnologije HP MJF v proizvodnji so se znatno znižali stroški, saj za izdelavo kompleksnih delov niso več potrebna 
posebna orodja, stroški izdelave pa so primerljivi tistim pri obdelavi z odrezavanjem. Zmanjšalo se je tudi skupno število delov 
različnih sestavov, saj tehnologija HP MJF močno olajša integracijo posameznih delov.

Ko se je število delov podsestava roke vzorčevalnika zmanjšalo z od 10 do 12 na samo dva, se je teža podsestava zmanjšala za 
40 %, proizvodni stroški pa kar za 65 %.

Zamenjava kovinskega dela v pladnju z reagenti za vzorce s komponento, izdelano po postopku HP MJF, je pomenila zmanjšanje 
števila delov s 26 na dva, strošek izdelave sestava pa se je znižal s 350 € na 200 €, oziroma za kar 43 %. Pri drugem predelanem 
pladnju za reagente je prehod s kovinske komponente na del, ki je v celoti izdelan po postopku HP MJF, prinesel 28,5-odstotni 
prihranek pri stroških (ti so se zmanjšali s 350 € na 250 € na izdelek), kar pri letni proizvodnji 300 enot pomeni prihranek v višini 
skoraj 60.000 €.

Na kosovnici nosilne konstrukcije za elektroniko in mehanske elemente naprave Hemo One sta zdaj samo še dva dela (prej 6), 
stroški pa so se zmanjšali s 25 € na 6 € na sestav, oziroma za 76 %.

»Danes lahko zahvaljujoč tehnologiji HP MJF projektiramo in izdelujemo končne izdelke z nekaterimi komponentami, ki jih prepros-
to ne bi bilo mogoče narediti na strojih za obdelavo z odrezavanjem,« je povedal Ramalli.

»V prihodnjih mesecih nameravamo nadaljevati z optimizacijo drugih delov, ki jih proizvajamo s tradicionalnimi tehnologijami. 
Tako bomo še dodatno zmanjšali število sestavov, prihranili prostor v skladišču ter zmanjšali stroške in količino odpadkov,« je 

Fotografije: Everex s�r�l�
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povedal Lorenzo Balli, izvršni direktor družbe Everex. »Prepričani smo, da bomo lahko tudi pri novih izdelkih skrajšali razvojni čas 
in zmanjšali število sestavnih delov instrumentov za nižje skupne stroške. Na osnovi HP-jeve tehnologije in znanja, ki smo ga pri-
dobili v našem podjetju, nadaljujemo pomembno razvojnoraziskovalno delo na instrumentih za analize IVD. Za naslednji dve leti 
tako načrtujemo več kot 30-odstotno povečanje prometa v segmentu IVD.« 

Tehnologija 3D-tiskanja HP Multi Jet Fusion tudi pri nas
Podjetje CGS plus ima na sedežu na Brnčičevi ulici 13 v Ljubljani predstavitveni salon 3D-tiskalnikov HP, v katerem si lahko 
tiskalnika MJF 4200 in MJF 580 Color ogledate v živo. Izkušena ekipa certificiranih strokovnjakov vas bo vodila skozi postopek 
priprave in odgovorila na vsa vprašanja, ki vas zanimajo v zvezi s 3D-tiskanjem. Pomagamo vam tudi pri projektih razvoja no-
vih izdelkov ali optimizaciji obstoječih. Za vse, ki želijo načrtovati izdelke za tehnologijo MJF, imamo na voljo tudi brezplačen 
priročnik z napotki. 



za programsko opremo Inventor in Fusion360. 

CAD, CAM in CAE*

www.cgsplus.si/izobrazevanja/

CAD, CAM in CAE*

splus.si/izobrazevanja/

Osnovni teèaj Inventor
Izdelki iz ploèevine v Autodesk Inventorju:

Fusion360 - Od skice do kosa:
Fusion360 - Sestav in risba:
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Uporaba simulacij za 
verifikacijo delovanja 

hitrih povezav v 
telekomunikacijskih enotah

Aviat Networks
Aviat d.o.o

Avtort: Gregor Polanšek
gregor.polansek@aviatnet.com

Članek v uvodnem delu pojasni razloge za uporabo simulacij pri načrtovanju telekomunikacijskih enot s hitri-
mi povezavami. Nato opiše katere vrste povezav v podjetju Aviat simuliramo na naših enotah in kaj so vzroki 
za to. Sledi del kjer bolj podrobno opišemo izvajanje simulacij hitrih povezav. Na koncu pa so predstavljeni 
izzivi, ki nas v zvezi s hitrimi povezavami čakajo v prihodnosti na Aviat telekomunikacijskih enotah.

 
In the article introduction reasons for high speed signal simulations during telecommunication board design 
are presented. Later in article type of high-speed signals, which are simulated on Aviat boards are presen-
ted and what are the reasons for that. Further on detailed descriptions of high-speed signal simulations 
are described. In article conclusion future challenges related to the high-speed signal simulations on Aviat 
boards are presented.

Aviat Networks na svojih digitalnih enotah, ki sestavljajo omrežno opremo, uporablja hitrosti signalov do 10Gb/s.  Pri teh hitrostih 
oziroma frekvencah se na enotah pojavijo stranski (parazitni) učinki, ki vplivajo na integriteto povezav oziroma signalov. Digital-
ne signale je potrebno začeti obravnavati kot analogne, digitalni inženirji morajo tako poznati kar nekaj analognih lastnosti zelo 
hitrih povezav. Ukvarjajo se na primer s slabljenjem preko linije (insertion loss) in odboji na linijah (return loss) preko nekega fre-
kvenčnega območja. Pri simulacijah hitrih signalov se zelo pogosto uporabljajo S-parametri signalov, ki nam dajo zelo dobro sliko 
frekvenčnega odziva  določenega signala.

Izvajanje simulacij ima dva namena. Prvi in najpomembnejši namen je, da se preveri, če izvedena končna geometrija vezja (layout) 
izpolnjuje zahteve za prenos hitrega signala. S tem se zagotovi, da bo enota že v prvem poskusu delovala in izpolnila zahteve 
glede zmogljivosti. Ta korak posredno omogoča, da se v najkrajšem možnem času zaključi razvoj same enote v smislu strojne 
opreme in da tudi druge ekipe, ki razvijajo programsko opremo, načrtujejo FPGA vezja itd., lahko čimprej štartajo z razvojem in ga 
posledično prej zaključijo. Zgoraj našteto pripomore k hitrejšemu nastopu na trgu (time to market), kar omogoča višje dohodke 
firme in posledično več možnosti za dodatna vlaganja v razvoj.

Drug namen je spoznavanje samih signalov in sklopov enote. 
Simulacija da zelo dober vpogled v delovanje določenih sklo-
pov enote. V primeru da nek sklop ne deluje oziroma ne dosega 
zahtevanih zmogljivosti, dobro poznavanje delovanja določe-
nega sklopa, pridobljeno tekom izvajanja simulacij, omogoča, 
da hitreje ugotovimo napako v njegovem delovanju ali hitreje 
izboljšamo delovanje oziroma zmogljivosti tega sklopa.
Vrste hitrih povezav v simulacijah

Simulacije hitrih povezav najbolj tipično uporabljamo pri hi-
trih Ethernet vmesnikih na serijskih diferencialnih paricah, pri 
DDRx pomnilnikih, pri občutljivih analognih signalih, pri hitrih 
urah in napajalnih plasteh za napajanje analognih sklopov.

Ethernet vmesniki na diferencialnih paricah pri nas nastopajo s 
hitrostmi do 10Gb/s, tako da se pri teh signalih že pojavijo vpli-
vi parazitnih elementov. Največji vpliv na degradacijo diferenci-
alnih paric imajo PCB skozniki. Skozniki predstavljajo dodatno Slika 1: Vpliv štrclja skoznika na prenosno karakteristiko signala

»

                  «
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induktivnost in kapacitivnost na linijah, ki upočasni signale in s 
tem prispeva k zapiranju očesnega diagrama signala. Še večji 
vpliv pa ima štrcelj, ki ga lahko predstavlja del skoznika, ki ni v 
poti signala. Štrcelj povzroči odboj zakasnjenega dela signala, 
ki lahko močno degradira signal, kar se zelo lepo vidi na preno-
sni karakteristiki linije (slika 1).

DDRx pomnilniki se na Aviat enotah uporabljajo tako za glavni 
pomnilnik procesorja kot za začasno shranjevanje Ethernet pa-
ketov, ki ga uporablja Ethernet stikalo oziroma usmerjevalnik. 
Pri DDRx pomnilnik se simulirajo oblike posameznih signalov, 
zakasnitve signalov po enoti in zakasnitve signalov proti uri. 
Hitrosti signalov gredo z DDR4 pomnilniki preko 3Gb/s, z na-
pajalno napetostjo 1,2V in referenčno napetostjo 0,6V pa se 
napetostni nivoji, ki predstavljalo logični nivo nič in ena zelo 
zbližujejo. Hitrost delovanja in ožji napetostni nivoji  zahtevajo 
bolj skrbno načrtovanje DDRx vmesnikov z namenom, da se 
izognemo napakam pri delovanju DDRx vmesnikov.

Hitrosti urinih signalov na Aviatovih enotah so do 156,25MHz (za potrebe 10G Etherneta), napetostni nivoji pa tipično LVPECL. Pri 
teh simulacijah nas najbolj zanima, da na prehodih ure iz nič v ena in obratno ni kakšnega odboja signala oziroma prevoja, ki bi 
utegnil povzročiti dodaten impulz ure na sprejemniku. S simulacijo tudi najlažje določimo serijske in paralelne terminacije, ki jih 
potrebujejo LVPECL ure. Proces iskanja optimalne zaključitve signala je precej lažji v simulaciji, kot pa na sami enoti, kjer je fizično 
potrebno spreminjati elemente in za vsako spremembo ponovno izvajati meritve signalov.

Pri analognih signalih, preko katerih se prenaša 4096QAM modulacija ali višja je potrebno zagotoviti zadostno izolacijo med posa-
meznimi analognimi signali (oddajni proti sprejemnemu, I proti Q itd.). Izolacija oziroma presluh med analognimi signali je v rangu 
-70dB. Simulacija nam pokaže ali je izolacija med različnimi signali zadostna.

Danes imajo določena digitalna vezja zahtevo da napajalna napetost za jedro vezja ne odstopa za več kot 3% navzgor ali navzdol 
od nominalne vrednosti. Pri tokovih nekaj deset amperov je težko zagotoviti, da pri distribuciji napajanja ne pride do prevelikih pad-
cev napajalne napetosti za to vezje. Zato izvajamo tudi simulacijo padcev napajalnih napetosti preko tiskanine, da zagotovimo, 
da imajo vezja ves čas delovanja (od vklopa napetosti do stanja maksimalne obremenitve) napajalno napetost v okviru zahtev.

Pri analognih vezjih se zahteva zelo stabilno napajanje s čim manj izmenične komponente v napajalni napetosti (nekatera analo-
gna vezja zahtevajo le 1mV izmenične komponente). Včasih poleg samega napetostnega pretvornika, filtriranja z induktivnostmi 
in kapacitivnostmi, na izmenično komponento v napajalni napetosti vpliva tudi frekvenčni odziv napajalne plasti oziroma distribu-
cije napajanja iz pretvornika do vezja, ki to napajanje uporablja 
(PDN – power delivery network). Če ima napajalna plast ravno 
pri frekvenci, s katero deluje vezje, ki ga ta napajalna napetost 
napaja, največjo impedanco, to pomeni, da prihaja do velikega 
padca napetosti na napajalni plasti in posledično do visokega 
nivoja izmenične komponente na napajalni napetosti (slika 2). 
Če frekvenčne simulacije odkrijejo prevelike impedance v do-
ločenem frekvenčnem področju, se razišče predvsem, kako se 
napajalni pini vezja in blokirni kondenzatorji povezujejo v napa-
jalne plasti (poskuša se zmanjšati induktivnost teh povezav), 
alternativno pa se na obravnavano napajalno napetost doda 
kapacitivnosti z nizko parazitno upornostjo in induktivnostjo.

Izvajanje simulacij
Pri hitrih serijskih vmesnikih se za preverjanje delovanja do-
ločenega vmesnika uporablja frekvenčni odziv linije (insertion 
loss) ali pa simulacija očesnega diagrama pri sprejemniku si-
gnala.

Če se ukvarjamo s standardnim vmesnikom, kot je na primer 
Ethernet 10Gbase-X vmesnik, je slabljenje kanala definirano v 
standardu za ta Ethernet vmesnik. Pri simulacijah takšnega 

Slika 2: Frekvenčni odziv napajalne plasti

Slika 3: Frekvenčni odziv 10GBase-X linije
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vmesnika je zadosti opazovati frekvenčni odziv linije in ga pri-
merjati z maksimalnim slabljenjem, ki ga definira standard za 
določen vmesnik (slika 3, rumena barva predstavlja slabljenje 
signala, modra barva pa maksimalno dovoljeno slabljenje si-
gnala).

Pri nestandardnih vmesnikih pa s simulacijo pridobimo očesni 
diagram (slika 4) pri sprejemniku signala in preverimo, če je 
odprtost očesnega diagrama zadostna za sprejemnik, ki ga 
uporabljamo. Pri tem se opiramo na nivo signala, definiranega 
v tehnični dokumentaciji sprejemnika, ki ga sprejemnik zahte-
va za zanesljivo detekcijo nivoja vhodnega signala.

V primeru, ko frekvenčni odziv oziroma očesni diagram ni v 
skladu z zahtevami, je potrebno analizirati, kaj se lahko izboljša 
pri vodenju signala po tiskanini, da bi dosegli manjše slabljenje 
oziroma bolj odprt očesni diagram. 

Včasih za to analizo zadostuje že pregled vodenja signala po tiskanini, pri katerem ugotovimo kakšne od bolj očitnih pomanjkljivo-
sti vodenja signala. Pri hitrih signalih na povečanje slabljenja najbolj vplivajo štrclji, ki jih predstavljajo skozniki, ki potekajo preko 
celotne debeline plošče (slika 1). Za izboljšavo slabljenja je le te potrebno zamenjati s skozniki, ki potekajo samo med dvema 
plastema tiskanine (slabost teh skoznikov pa je višja cena tiskanine, saj ti skozniki pomenijo dodaten korak pri proizvodnji tiska-
nine) ali pa povrtati del skoznika, ki predstavlja štrcelj.

Pri bolj zahtevnih signalih ali bolj skritih pomanjkljivostih na signalih pa danes orodja omogočajo, da se določeno linijo izvozi 
v električno shemo (slika 5). Iz fizične linije tako dobimo shemo, ki vključuje prenosne linije z njihovimi kapacitivnostmi, induk-
tivnostmi, upornostmi in zakasnitvami, pasivne elemente, konektorje podane z S-parametri ali Spice modeli. V tej shemi so tudi 
vključeni električni modeli skoznikov. Možno je spreminjati določene komponente ali dele sheme in tako ugotoviti kaj najbolj vpliva 
na slabljenje hitrega signala. Ko v električnem modelu linije ugotovimo, kaj izboljša karakteristiko, je to potrebno prenesti nazaj v 
fizični svet oziroma v vodenje linije preko tiskanine. Sledi ponovna simulacija izboljšane linije hitrega signala. V enem ali včasih 
več iteracijah tako pridemo do zahtevane karakteristike hitrega signala.

Za vsako enoto, na kateri so vezja z večjo porabo, opravimo tudi simulacijo padcev napetosti preko napajalnih plasti. Želimo 
namreč izvedeti, kakšen je padec napetosti na določeni enoti preko same tiskanine in preko induktivnosti za glajenje napajalne 
napetosti. Na sliki 6 je prikazan padec napetosti preko plasti mase v tiskanini.  

Iz grafičnega prikaza zgoraj se vidi, da je padec napetosti preko masne plasti precej enakomeren, napetost počasi pada od napa-
jalnika na levi strani plošče proti porabnikom na desni strani plošče. Razlogi za večji padec napajalne napetosti po plasti so lahko 
zožitve napajalne ali masne plasti ali množica skoznikov, ki zmanjša površino za distribucijo napajalne napetosti. V primeru, da se 
s simulacijo odkrije prevelike padce napetosti, je potrebno spremeniti tiskanino (običajno se razširi napajalne plasti in bolj enako-
merno razporedi skoznike), da se zagotovi boljšo distribucijo napajanja preko plošče oziroma manjši padec napajalne napetosti.
Izzivi na področju simulacij hitrih signalov

V prihodnosti pričakujemo dvig najvišje hitrosti signalov na digitalnih Aviat enotah iz 10Gb/s na 25Gb/s. Občutno povečanje 

Slika 4: Simulacija očesnega diagrama

Slika 5: Električna shema dela signala na tiskanini
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hitrosti signalov bo občutno povečalo tudi 
zahtevnost pri načrtovanju tiskanine enote in 
izvajanju samih simulacij. 
Vsi parazitni elementi pri hitrosti 25Gb/s do-
bijo večji pomen, kar pomeni, da bolj vplivajo 
na degradacijo hitrega signala.

Materiali za tiskanine, ki jih trenutno uporab-
ljamo, verjetno ne bodo primerni za 25Gb/s 
hitrosti. Potrebno bo uporabiti materiale na-
menjene uporabi za še hitrejše signale (Meg-
tron 6/7, Rogers).

Vodenje signala po tiskanini bo potrebno iz-
vesti še bolj skrbno. Število skoznikov, preko 
katerih gre hitri signal, bo treba še zmanjšati. 

Pri simulacijah se bo povečal čas za analizo frekvenčnega odziva linij. Zaradi zahtev po slabljenju, ki gredo do 25GHz, bo več 
neželenih učinkov parazitnih elementov, ki jih bo potrebno s pomočjo simulacije odpraviti. Vsekakor bo več časa potrebnega za 
izvajanje simulacij in analize rezultatov simulacij.

Izziv vidim tudi pri pridobivanju kvalitetnih električnih modelov za konektorje in pasivne elemente, kot so kondenzatorji. Pridobiti 
bo potrebno bolj natančen električni model od današnjega, saj se določene parazitne vrednosti pojavijo oziroma pridejo do izraza 
šele pri visokih frekvencah. V primeru, da modeli ne bodo na voljo do frekvenc 25GHz in več, bo s pomočjo 3D orodij potrebno 
narediti 3D model na primer konektorja in ga s pomočjo specialnega orodja pretvoriti v natančen električni model za simulacijo.

Trenutno pridobljeno znanje bo potrebno še nadgraditi in ga uporabiti pri načrtovanju novih enot s še hitrejšimi signali, ki bodo v 
prihodnosti potovali preko naših enot.

Slika 6: Padec napetosti preko plasti mase v tiskanini
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Avtomatizacija industrijskih 
meritev z internetom 
stvari na dublinskem 
Kolidžu svete Trojice

ADD ProS d.o.o.
Avtor: Andrej Drozg
www.add-pros.com

www.ni.com

Globalno vodilni ponudnik infrardeče ogrevalne tehnike in storitev Ceramicx Ireland se je nedavno soočil z 
zahtevnim izzivom pri preskušanju svoje obširne palete izdelkov, ki obsega več kot 150 različnih vrst delov. 
Vse meritve morajo potekati hitro, dosledno in natančno. V reševanje tega večrazsežnostnega problema se je 
vključila tudi akademska sfera, rešitev pa izkorišča moč industrije 4.0 in vizijo pametnih tovarn prihodnosti.

Rešitev
V okviru projekta CIRCLE, pri katerem so sodelovali raziskovalci podjetja Ceramicx in dublinskega Kolidža svete Trojice (TCD), je 
bil razvit popolnoma avtomatiziran in prilagodljiv sistem za preskušanje in validacijo izdelkov. Preizkušanci (DUT) so keramični 
in kvarčni grelni elementi raznih velikosti in oblik ter z različnimi mehanskimi in električnimi lastnostmi. Projekt CIRCLE osvetljuje 
pomen infrastrukture na osnovi industrijskega interneta stvari (IIOT) pri decentralizaciji procesov testiranja z namenskimi testnimi 
postajami, v katerih so vgrajeni krmilniki NI CompactRIO za vodenje v realnem času. Vsaka testna postaja je opremljena s svojimi 
merilnimi napravami in aktuatorji, npr. z visokonapetostnimi testerji, infrardečimi kamerami in motornimi pogoni.
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Ustvarjanje decentralizirane arhitekture IIoT
Decentralizirana arhitektura zahteva uporabo nadzornika v megli ali oblaku, ki vodi postaje pri izpolnjevanju enotnega cilja. Nad-
zornik v projektu CIRCLE je komunikacijsko vozlišče, ki nadzoruje, konfigurira in upravlja testne postaje prek omrežja. Tim razisko-
valcev na TCD je program nadzornika razvil v okolju LabVIEW in izdal v obliki izvršljive datoteke za operacijski sistem Windows. 
Nadzornik identificira program, ki se mora izvajati za DUT na posameznih testnih postajah (vozliščih na robu omrežja). Pri tem 
uporablja programski portal-vtičnik, ki omogoča tudi ostalim razvijalcem iz akademskih krogov in industrije integracijo program-
skih aplikacij in podatkovnih storitev po meri.

»Z razvojem novih testnih postaj bomo tako lahko brez težav vključevali nove teste. Spremembe posameznih testnih postaj ne 
vplivajo na delovanje ostalih testnih postaj,« poroča dr. Jeff Morgan s TCD. »Krmilnik CompactRIO vsake povezane testne postaje 
lahko komunicira z ostalimi krmilniki CompactRIO in s sistemskim nadzornikom s pomočjo programske opreme, ki smo jo razvili 
v okolju LabVIEW. Tako smo ustvarili popolnoma povezan in interoperabilen sistem, ki je zmožen prave vzporedne obdelave z 
decentraliziranimi procesorji.«

Definiranje najnaprednejše tehnologije
Industrija 4.0 bo mogoča le s konvergenco visokozmogljivega in nizkocenovnega računalništva in komunikacije. Proizvajalci, ki 
želijo ostati konkurenčni, morajo biti prilagodljivi za hitro odzivanje na nenehno spreminjajoče se zahteve trga. Raziskovalci v 
projektu CIRCLE verjamejo, da decentralizirano upravljanje in sodelovanje uspešno izpolnjujeta zahteve progresivnih proizvodnih 
podjetij. Arhitekturna osnova za to je platforma za pametno izvajanje testov z možnostjo preoblikovanja SR-TEX (Smart Recon-
figurable Test EXecution). Gre za univerzalno in decentralizirano platformo za spremljanje, nadzor in upravljanje, ki jo je mogoče 
uporabiti na vsaki avtomatizirani liniji za vzporedno preskušanje in validacijo izdelkov.

S partnerstvi do sredstev
Močna partnerstva, kot je CIRCLE, lahko nastanejo le, ko se akadamska sfera poveže z industrijo pri doseganju skupnih ciljev. 
Obstaja večja verjetnost, da bodo inovativne raziskave spremenile svet, če jih podprejo globalne avtoritete iz akademskih krogov 
in vrhunski strokovnjaki iz industrije, ki so tehnologijo sposobni pripeljati na trg.

Tradicionalna izjava o podpori raziskovalnemu predlogu je le en prispevek, s katerim lahko industrijski partner pripomore k uspehu 
akademskih raziskav. Pravi partner iz industrije lahko raziskovalcem pomaga pridobiti dostop do znanja, vpogleda v problematiko, 
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tehnologije in veščin, ki močno prispevajo h kredibilnosti raziskovalnega načrta. Pristop z osredotočenjem na izdelavo prototipov 
v smeri tehnološke pripravljenosti in razvoja novih izdelkov, ki sta ga za svojo rešitev uporabila kolidž TCD in CeramicX, lahko ko-
risti razvoju danes ključnih raziskovalnih področij, kot je industrija 4.0.

Celotna študija primera je na voljo na naslovu ni.com/academic/research.

Beseda podpredsednika NI raziskovalcem
Raziskovalci vsak dan uporabljajo platformo NI za premikanje meja odkrivanja. Vodijo jih veliki 
izzivi, s katerimi se sooča človeštvo ter gospodarski in tehnični trendi, ki spreminjajo brezžične 
komunikacije, prevoz in energijo. Ideje, teorije in prototipi, ki se začnejo v laboratorijih za akadem-
ske raziskave, segajo v vse bolj zapletene aplikacije in sčasoma vplivajo na življenja vseh v obliki 
komercialne tehnologije. 

Tako raznoliki, kot je morda področje njihovih raziskovalnih središč, se akademiki soočajo s po-
dobnimi izzivi, ne glede na področje. Cilj NI je bil vedno pomagati znanstvenikom in inženirjem, 
da preživijo svoj čas na nečem novem in inovativnem, tako da ponudi natančnost, ponovljivost in 
prilagodljivost skozi platformo, ki jih potrebujejo za potrditev in prototip raziskav. 

Prispevek je del priročnika, ki nam služi kot prostor za izmenjavo spoznanj in najboljših praks sve-
tovne raziskovalne skupnosti skozi predstavitve novih raziskav, izvedenih s pomočjo platforme NI.

ni.com/academic/researchDavidWilson, Podpredsetnik 
za trženje izdelkov program-
ska oprem, akademiki in izo-
braževaje strank
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Probing Signals in 
High-Speed Digital Designs

Amiteh
Autor: Mirko Ivančič

V predavanju želimo predstaviti, kaj je treba upoštevati pri povezovanju digitalnih signalov visokih hitrosti 
kot npr. DDR, MIPI, USB, HDMI na merilnike, npr. osciloskope.

Beware of uncontrolled input leads

What’s the weakest link in the chain?

InfiniiMax I/II probe architecture
This uncontrolled ~4 mm tip leads may have a huge effect on the performance of your probe and the entire measurement system.
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Varying lead length/span affects probe bandwidth
InfiniiMax II N5425B ZIF head + N5426A ZIF tips or N5451A Long-wire ZIF tips.

Varying lead length/span can greatly affect the flatness of the frequency response
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Varying lead length/span can affect the probe loading too

Summary – beware uncontrolled input leads
• Probe accessories can greatly affect the overall bandwidth, frequency response and loading characteristics.
• Keep it short!
• Keep the loop area of the tips as small as possible.

Probe loading considerations
Probe loading in a nutshell

This child’s body temperature drops as his mom places her 
hand. It changes his body temperature as his mom takes away 
the temperature. 

Probe loading is just like this. Connecting a probe to the DUT 
can change the circuit behavior (amplitude, rise/fall time, 
offset, time delay etc).

Why probe loading matters
• As mom’s hand is placed the boy’s temperature drops to 

37.8 degC.
• One may estimate it might have been 38 degC, but in reality, 

the temp is no longer 38 degC. It is 37.8 degC.
• A probe with poor loading characteristics may change your 

circuit behavior, regardless of the waveform the scope 
shows you.

• Keysight InfiniiMax probes are designed to show you the 
signal at the tip as loaded by probe.
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Probe loading – a circuit level view
• Probe becomes an additional load driven by the signal source and can change the operation of the DUT.
• Resistive, capacitive and inductive loading effects must be considered.
• Pay careful attention to capacitive loading as your system bandwidth gets higher.

Lower capacitance lets you use higher impedance over wider frequency ranges 
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Two common probe impedance profiles

DDR memory dynamic on-die termination (ODT) modes
How large is your probe input impedance relative to the source impedance?
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Probing a LPDDR4 memory bus with switching impedance
• Probe loading effect makes difference in two waveforms.
• RC probe is a better choice when probing buses that transition to a “high Z” state or when dealing with signal with high impedance.

Probe loading effect in measuring MIPI D-phy
For D-PHY HS mode, signals are terminated into 50-ohm single-ended to ground. For LP mode, the signals are unterminated or 
open to minimize current flow to save power.
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Summary – Probe loading
• Pay careful attention to capacitive loading as your system bandwidth gets higher. 
• As the input capacitance gets lower, probe maintains higher impedance for wider frequency ranges. 
• There are two types of loading characteristics for probes – RC vs RCRC profiles where RC probes being for more general purpose 

and RCRC probes for high BW, low impedance target.
• For InfiniiMax probes, probe input impedance is the function of probe head, not probe amp.
• Beware using the RCRC probe for the target with high input impedance or the source impedance switching between high and 

low values. 

Probe response corrections
Your probe… yesterday and today
• In the old days, the bandwidth and accuracy of the high-end 

probe relies on their inherent hardware response.
• It was typically enough for the performance levels needed 

at that time.
• However, as newer generation probes with higher bandwidth 

came along, the need for higher and more consistent 
accuracy has been growing to minimize the probe variation 
effect.

Enhanced probe response with DSP correction
• To address the need for better performance and increased 

accuracy, high performance probes started utilizing 
measured response of the probe system to DSP correct and 
enhance the hardware response. 

• Currently, Keysight InfiniiMax II, III and III+ probe systems 
use S parameter for correcting probe responses. No 
correction for InfiniiMax I.

• On the probe menu of the Infiniium software, you can choose 
the S parameter of a probe head in the probe head selection 
menu. It is combined with the S parameter of the probe amp 
to correct the response of the whole probe system.
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Important variation factor to keep in mind..
Keysight provides S parameter correction filters for all these 
components based on standard tip configuration.
However, other factors such as the variation in probe tip 
configuration such as
• tip length,
• tip span,
• arrangement of wires,
• partial damage, and
• probe orientation to DUT can still affect probe response.

AC response calibration options
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Advanced probe correction method using PrecisionProbe
• The ideal way to ensure the best accuracy for a probe is to perform a calibration of its response in the configuration that it will 

be used before critical measurements are made.
• The PrecisionProbe application uses the fast calibration step signal and a high quality probe fixture with cables to accurately 

measure and correct for the response of any probe. 

Capacitive and inductive loading plot
• Another very useful result furnished by the 

Precision Probe application is a plot of the 
measured input impedance of the probe and 
adjustable measurement lines to determine the 
capacitive and inductive loading of the probe.

• Note that the PrecisionProbe may be able 
to show you the signal the way you want, but 
probe loading is still there impacting the target 
signals. Always!

PrecisionProbe vs InfiniiSim
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Spice models for probe loading effect simulations
• Spice models for all InfiniiMax probe heads/amps are supplied in the InfiniiMax user’s manuals.
• Only input impedance models are supplied for modeling probe loading
• Cut/paste the spice deck into a regular txt file and import into programs like Pspice.

Summary – Probe response correction
• Keysight provides S parameter correction filters for InfiniiMax probe amps and heads based on standard tip configuration.  
• Other factors such as the variation in probe tip configuration can still affect the probe response.
• PrecisionProbe application accurately measures and corrects for the response of any probe in the configuration it will be used. 
• PrecisionProbe may be able to show you the signal the way you want, but probe loading is still there impacting the target signals. 

Always!

Probing in extreme conditions
Small Geometry Probing – Key Drivers
Target devices (connection pads, SMD, vias, interposers etc.) are ever getting:
• Smaller
• Denser with lots of signal to look at in tight space
• More challenging with narrow spacing between PCAs
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Small Geometry Probing Challenges
• DDR memory probing – lots of signals to look at in very tight 

space!
• DUT size gets smaller and smaller, resulting in smaller pads 

and narrower pitch spacing that make probing job ever more 
challenging.

New MX0100A micro probe head
Uncompromised access to your fine pitch devices:
• < Half the size of existing solder-in probe heads
• Small, flat and flexible (using flex printed circuit)
• Full probe amp bandwidth (>12GHz with 1169B)
• Excellent probe loading (0.17 pF)
• Compatible with “RC” probe amps (InfiniiMax I/II and next generation 

RC probes)
• Reusable
• Wider operating temp range : -55 to +150 degC (per JEDEC JESD22 

-A104 revision E spec)
• Half the price of existing solder-in heads Uncompromised access to 

your fine pitch devices
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The life span of the head is highly dependent on how you use it!
• The life span of the head is highly dependent on how you use it!
• Microscope is a MUST have tool.
• Highly recommend low temp solder such as SAC (Tin-Silver-Copper with 220 degC melting 

point), or tin-bismuth with 138 degC melting point with the temperature-controlled solder 
iron with the tip temp set as low as possible.

• Use a small solder tip (<1mm tip).
• Don’t apply heat on the probe lead for long time. Use <2 sec of dwell time on the joint. 
• Strain relieve the head and amp if possible. Use Kepton tape, putty, low temp glue etc.
• Apply flux at the DUT and solder head tip for easier solder flow.

Application note on InfiniiMax probe 
soldering guidelines (5992-3350EN)

Oscilloscope Probing in Extreme Temperature
Temperature test ranges and applications
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Extended Temperature Probing with InfiniiMax Probes, 
as wide as -55 to +155 degC 
MX0100A : 12 GHz Micro Solder-in Probe Head (RC)
• < Half the size of existing solder-in probe heads
• Small, flat and flexible (using flex printed circuit)
• Compatible with any InfiniiMax I/II RC probe amps
• Operating temp range: -55 - +150°C

MX0109A : 26 GHz Solder-in Probe Head
• 26 GHz bandwidth
• Same performance as N2836A
• Compatible with InfiniiMax III/III+ RCRC probe amps
• Operating temp range: -55 - +150°C

MX0109A frequency response variations over temp
Vout/Vin variation over +160 to -55 degC temperature is fairly small
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InfiniiMax probe heads – operating temperature ranges

Keysight’s Extreme Temperature Probing Solution
Keysight offers the broadest selection of extreme-temperature oscilloscope probing solutions. www.keysight.com/find/extreme.
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Probe Resource Center (PRC) available on a new HTML platform
• Probe Resource Center (PRC) has been a free Adobe AIR-based application that contains Keysight scope probe information and 

allows customers to efficiently browse or search for probing information in one easy-to-access location.
• Updated to a new web based HTML5 format which is suitable for Windows, Mac, Android, or iOS devices and can also be 

downloaded for offline references.
http://prc.keysight.com

Keysight Oscilloscope Probes and Accessories
Wide selections from 50 MHz to 33 GHz

www.keysight.com/find/probes
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Umetna inteligenca na 
končnih napravah

UM FERI
asist. Grega Močnik, mag. inž. ele., FERI Maribor

grega.mocnik@um.si
asist. Danilo Zimšek, uni. dipl. inž. tk., FERI Maribor

danilo.zimsek@um.si
 https://www.um.si
 https://feri.um.si

Vse več problemov zelo učinkovito rešujemo z uporabo umetne inteligence. Algoritmi, ki jih pri tem uporab-
ljamo mnogo krat zahtevajo veliko računskih virov, zato se za implementacijo inteligence v večini sistemov 
uporabljajo implementacije v oblačne storitve, kjer končne naprave komunicirajo s storitvijo v oblaku. Ta pa 
izvaja računsko zahtevne algoritme s pomočjo pridobljenih podatkov. Vendar tak način implementacije ni 
primeren za vse primere uporabe. Pri varnostno kritičnih uporabah, kot je na primer avtonomna vožnja, je 
potrebno zagotoviti majhno zakasnitev med računskimi postopki, pri uporabi oblačne storitve pa nastane 
časovna zakasnitev, ki je posledica procesiranja in prenosa podatkov med končno napravo in storitvijo v 
oblaku. Poleg tega se pojavi težava zagotavljanja stabilne in zanesljive povezave do oblačne storitve, zlasti, 
ker se končna naprava premika. V takih primerih je potrebno algoritme umetne inteligence implementirati na 
končni napravi, v primeru avtonomne vožnje na napravi v vozilu. 

Strojna oprema za inteligenco v vgrajenih sistemih
Pri implementaciji algoritmov umetne inteligence na končni napravi smo pogosto omejeni z računskimi zmogljivostmi, neposred-
no še z baterijskim napajanjem in fizično velikostjo. Za implementacijo algoritmov umetne inteligence je pogosto najučinkovitejša 
strojna oprema z veliko računskimi jedri, ki delujejo vzporedno. Vzporedno računanje nek postopek bistveno pohitri, podporo 
takšnemu računanju izkazuje t.i. platforma CUDA, podjetja NVIDIA. Podjetje NVIDIA trži procesorske module in razvojne plošče z 
veliko grafičnimi jedri s platformami CUDA, z jedri CUDA in platformami z jedri Tensor, celoten asortima izdelkov ima majhno po-
rabo energije. Takšne rešitve so kot nalašč za implementacijo v vgrajenih sistemih. V nadaljevanju na kratko povzamemo glavne 
značilnosti trenutno aktualnih modulov. Jetson nano kljub nizki ceni in majhnosti (70 x 45 mm) razpolaga s 128 CUDA jedri in je 
ob nizki porabi 5-10 W lahko primeren za implementacijo umetne inteligence v gospodinjskih robotih ali za osnovno procesiranje 
dogajanja v napravah za video nadzor. Jetson TX2 z 256 CUDA jedri in porabo 7-15 W električne moči je primeren za uporabo v 
industrijskih robotih in medicinski opremi. Za najzahtevnejše aplikacije, kjer potrebujemo veliko CUDA jeder (384 oz. 512) lahko 
uporabimo Jetson Xavier NX ali Jetson AGX Xavier, ki lahko ob porabi 10 do 15 in 10 do 30 W električne moči vzporedno poganjata 
več nevronskih mrež. Poleg jeder CUDA imata tudi Tensor jedra. Primerna sta za implementacijo avtonomnih robotov v industriji, 
ki za avtonomno odločanje potrebujejo več podatkovnih vhodov. V nadaljevanju bo podrobneje predstavljena modul in razvojna 
plošča Jetson TX2. 

Modul Jetson TX2
Sistemi NVIDIA Jetson zagotavljajo zmogljiv in energetsko 
učinkovit sistem z namenom implementacije programske 
opreme, ki zagotavlja čim večjo avtonomnost aplikacijam. 
Modul Jetson TX2, na sliki 1, je tako imenovani sistem na 
modulu (angl. System on Modul), kar pomeni, da vsebuje na 
majhni površini tiskanega vezja centralno procesno enoto, ki 
je neposredno povezana z grafično procesno enoto dodan 
ima DRAM in bliskovni pomnilnik FLASH. Fizične zmogljivosti 
je mogoče z razširitvenim priključkom razširiti in ji dodati na 
primer Ethernet priključek, zunanje trajne pomnilnike in mno-
žico najrazličnejših komunikacijskih vodil (USB, SPI, I2S, ...).  
Izbran Jetson TX2 je podprt s 64 bitnim procesorjem Denver 
na katerem je procesor ARM z arhitekturo A57 in grafično pro-
cesorsko enoto NVIDIA Pascal, z 256 CUDA jedri. Pomnilnik 
je tipa DDR4 z velikostjo 4 GB, in s 16 GB velikim prostorom 
za shranjevanje podatkov. Sistem vsebuje dva povezljivostna Slika 1: Sistem na modulu Jetson TX2 
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sloja 10/100/1000 Ethernet in WiFi, ki pa mu je potrebno dodati še zunanjo periferijo kot je antena in integrirano vezje s fizičnim 
slojem. Ima tudi podporo za zunanji prikazovalnik preko vodila HDMI. 

Razvojna plošča Jetson TX2
Pogosto je v profesionalnem svetu razvito namensko tiskano vezje na katerem je modul Jetson TX2 v povezavi z aplikacijo v 
kateri se bo modul uporabljal. Zato, da naredimo prvi korak pri razvoju pa se pogosto odločimo, da vzamemo že narejeno ra-
zvojno ploščo, ki nam omogoči uporabo vseh funkcionalnosti modula Jetson TX2. Podjetje NVIDIA je izdelalo razvojno ploščo 
Jetson Developer Kit, na sliki 2, ki vsebuje priključke za Ethernet, USB, HDMI, anteni za WiFi in Bluetooth ter še nekaj razširit-
venih letvic za dostop do GPIO periferije. Prav tako vsebuje razvojna plošča tudi napajalni del celotne periferije. Poznamo tudi 
nekaj drugih razvojnih ploščic, ki pa niso bile razvite s strani NVIDIA ampak tretjih podjetij, razlikujejo se po namembnosti in po 
funkcionalnosti.

Priprava platforme Jetson TX2
Na razvojno ploščo Jetson je potrebno pred prvo uporabo namestiti operacijski sistem Linux, ki temelji na distribuciji Ubuntu. 
Najprimernejši način za namestitev operacijskega sistema na razvojno ploščo Jetson je z uporabo gostiteljskega računalnika 
preko kabla USB, na katerem naj bo nameščen Ubuntu Linux 18.04 ali 16.04. Na gostiteljski računalnik je potrebno namestiti 

Slika 2: Razvojna plošča Jetson TX2
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programsko orodje SDK manager, ki poskrbi za nameščanje sistema Jetpack na Jetson. Jetpack vsebuje vse knjižnice in orod-
ja, ki so potrebne za poganjanje modelov strojnega učenja.

Jetpack vključuje naslednje komponente: L4T, CUDA, okolje za poganjanje vsebovalnikov (angl. containers), cuDNN, TensorRT 
in OpenCV. 
• L4T – Linux for Tegra je operacijski sistem prilagojen za procesorje Tegra, ki so uporabljeni v modulih Jetson. Operacijski sistem 

je zasnovan na okolju Linux in je iz uporabniškega vidika zelo podoben distribuciji Ubuntu.
• CUDA programski vmesnik nam omogoči direkten dostop do jeder CUDA s pomočjo katerih lahko izvajamo vzporedno računanje 

oz. poganjanje postopkov. Uporablja se tudi za poganjanje zunanjih programov na grafičnih enotah. Omogoča nam, da s pomoč-
jo knjižnic, kot je BLAS optimiziramo delovanje grafično procesorske enote.

• Okolje za poganjanje vsebovalnikov omogoča, da vsebovalnike Docker poganjamo v povezavi z jedri CUDA. Na ta način dobimo 
enostavno prenosljive Docker vsebovalnike, ki uporabljajo GPU pospeševanje.

• cuDNN omogoči strojni opremi delovanje in optimizacijo široko uporabljenih programskih orodij za globoko učenje (na primer 
Tensorflow, cafe, pyTorch) na GPU.

• TensorRT je platforma, ki minimizira drevo strojnega učenja za modele in nekatere korake optimizira. Ker pa se vseh operacij ne 
da prevesti v operacije kompatibilne z operacijami TensorRT, platforma ni uporabna z vsemi modeli. 

• OpenCV je knjižnica, ki je široko uporabljena na področju aplikacij s strojnim vidom. OpenCV ni nujno potrebna komponenta, a 
se lahko izkaže za uporabno, saj vključuje veliko algoritmov procesiranja slik in funkcije za vizualizacijo, ki nam olajšajo pot do 
željenega rezultata.

Namestitev Jetpack
Po prenosu in zagonu SDK programske opreme SDK manager na gostiteljskem računalniku, v grafičnem vmesniku izberemo Jetson 
ploščo, na katero želimo namestiti sistem, program prenese potrebne programske pakete. V naslednjem koraku je potrebno povezati 
gostiteljski računalnik z razvojno ploščo Jetson z microusb kablom, ki je del razvojnega paketa. Jetson s pritiskom na gumb Recove-
ry preide v obnovitveni način delovanja. Nato se izvede namestitev programske opreme L4T BSP na Jetson. Po končani namestitvi 
se na Jetsonu zažene operacijski sistem. Na HDMI izhod plošče lahko predhodno priklopimo zaslon, na USB vhode pa miško in 
tipkovnico. Tako lahko z Jetsonom upravljamo neposredno. Jetson navadno želimo povezati tudi v internetno omrežje. Tako lahko 
neposredno nanj namestimo programske pakete za CUDO, cuDNN in ostale zgrajene za 64-bitno ARM arhitekturo. 

Učenje modelov umetne inteligence
Običajno nevronske mreže učimo na zmogljivejših sistemih z več grafičnimi karticami, ki so optimizirani za ta namen. Učenje bi 
lahko izvajali tudi na sami plošči posebno če uporabljamo najzmogljivejšo ploščo Jetson, vendar je nenapisano pravilo da strež-
niške sisteme uporabimo za učenje nevronske mreže in tako naučen model prenesemo na vgrajene sisteme, pri čemer nam lahko 
koristi tudi najrazličnejše storitve (npr. Amazon AWS, MS Azure), če nimamo fizičnega dostopa do sistemov z zmogljivimi grafični-
mi karticami. Za primer sprotnega učenja, pa nam prav pridejo zmogljivi vgrajeni sistemi, kot je Jetson TX2, na katerih poteka (ne)
nadzorovano učenje in sprotno odločanje. 

Velikokrat končne naprave kot so industrijski roboti, avtonomni avtomobili ipd. potrebujejo več naučenih modelov nevronskih 
mrež za svoje delovanje. Iz množice senzorjev zajemajo podatke, pri čemer so ti podatki realno časovno predprocesirani s pri-
mernimi naučenimi modeli v realnem času. Sledi odločitveno procesiranje, ki glede na izhode iz modelov izvede primerne akcije. 
Zaradi potrebe po več modelih, moramo tudi pri razvoju zagotoviti enostavni način učenja teh modelov in možnost kasnejše 
nadgradnje oz. spremembe modelov. Modeli so lahko zgrajeni z uporabo različnih orodij, kot so Cafe, pyTorch, Tensorflow, in 
drugi. Za poganjanje vsakega od orodij, moramo na sistemu, kjer ga poganjamo zagotoviti primerne verzije grafičnih gonilnikov, 
knjižnic CUDA, cuDNN in drugih, ki so programski vmesnik med strojno opremo strežnika na katerem poteka učenje modelovin 
aplikacijskimi orodji, kot je recimo TensorFlow. Zaradi tega se v večini primerov poslužujemo uporabe vsebovalnikov Docker. Ti 
nam omogočajo, da lahko na istem operacijskem sistemu poganjamo vsa potrebna različna orodja za učenje modelov. Poleg tega 
je podjetje NVIDIA vzpostavilo spletno storitev NVIDIA GPU Cloud, kjer so na voljo diskovne slike z vsebovalniki z že naučenimi 
modeli, ki jih je mogoče ponovno učiti, jim spreminjati zgradbo nevronske mreže in jih naučiti na drugem podatkovnem setu. Na 
ta način zagotovimo hiter razvoj novih prilagojenih modelov, ob tem pa se izognemo sistemskemu administriranju, ki velikokrat 
zahteva kar nekaj razvojnega časa. 

Pri učenju modelov je pogosto pomembna vizualizacija krivulje učenja in drugih parametrov. Hkrati je zmeraj dobrodošla uporaba 
vmesnikov, ki usmerijo pozornost od razvoja programov (v tem primeru so to programi za učenje modelov) k samemu učenju in 
optimizaciji parametrov. Takšen vmesnik je NVIDIA DIGITS. Uporabljamo ga za interaktivno učenje modelov mrež na označenih 
podatkovnih bazah. DIGITS je navadno nameščen na sistemih z več grafičnimi karticami, namestimo pa ga lahko v obliki vsebo-
valnika DOCKER, kar je enostavno za implementacijo. Z uporabo DIGITS preko grafičnega vmesnika določimo podatkovno bazo za 
učenje in model, ki ga želimo uporabiti. Zanj napišemo vmesnik – navadno preurejen DOCKER ukaz za zagon učenja, DIGITS nas 
nato seznanja z napredkom in vizualizira pomembne parametre učenja. 
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Poganjanje modela na platformi Jetson
Naučen model prenesemo na platformo Jetson, ga optimiziramo z uporabo tensorRT in ga uporabimo v željeni aplikaciji. Za vme-
snik do kamere lahko uporabljamo zunanje knjižnice, kot je na primer OpenCV. Za manipulacijo slik, ali če gre za implementacijo 
v programskem jeziku Python, pogosto uporabljamo Python Image Library ali druge. 

Zaključek 
Delovni tok za vgrajene sisteme Jetson se ne razlikuje veliko od razvoja funkcionalnosti, ki uporabljajo globoko učenje na platfor-
mah x86 ali x64. Glavna razlika je optimizacija modelov z uporabo orodja tensorRT. S tem dosežemo visoko učinkovitost modelov 
in naučene modele globokega učenja prenesemo na končne naprave. Za primer uporabe zmogljivejših naprav, kot je na primer 
NVIDIA Xavier AGX, lahko vzporedno poganjamo več modelov, kar ponuja nove možnosti razvoja naprav, ki se lahko dobro odzi-
vajo v zapletenih delovnih okoljih. 

Viri
• [Opis modula Jetson nano] https://developer.nvidia.com/embedded/jetson-nano
• [Opis modula Jetson TX2] https://developer.nvidia.com/embedded/jetson-tx2
• [Opis modula Xavier NX] https://developer.nvidia.com/embedded/jetson-xavier-nx
• [Opis modula AGX Xavier] https://developer.nvidia.com/embedded/jetson-agx-xavier
• [Primerjava strojne opreme NVIDIA] https://developer.nvidia.com/embedded/develop/hardware
• [Razvojna plošča Jetson TX2] https://developer.nvidia.com/embedded/jetson-tx2-developer-kit
• [Dodatna strojna oprema tretjih proizvajalcev] https://elinux.org/Jetson_TX2#Ecosystem_Products
• [Nvidia NGC] https://www.nvidia.com/en-us/gpu-cloud/
• [Jetson tutorial] https://developer.nvidia.com/embedded/twodaystoademo
• [Koda za Jetson tutorial] https://github.com/dusty-nv/jetson-inference

https://developer.nvidia.com/embedded/jetson-nano
https://developer.nvidia.com/embedded/jetson-tx2
https://developer.nvidia.com/embedded/jetson-xavier-nx
https://developer.nvidia.com/embedded/jetson-agx-xavier
https://developer.nvidia.com/embedded/develop/hardware
https://developer.nvidia.com/embedded/jetson-tx2-developer-kit
https://www.nvidia.com/en-us/gpu-cloud/
https://developer.nvidia.com/embedded/twodaystoademo
https://github.com/dusty-nv/jetson-inference
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KICAD in FREECAD 
interoperabilnost

Pistam d.o.o.
Žiga Lausegger, prof. fizike in tehnike

ziga@pistam.com

V članku je predstavljena medsebojna interakcija programov Kicad in Freecad preko katere lahko izdelamo 
3D model elektronskega vezja in pripadajočega ohišja. Najprej bo demonstrirano učinkovito upravljanje z 
uradnimi ter privatnimi Kicad zbirkami (a) elektronskih simbolov, (b) podnožij in (c) pripadajočih 3D modelov. 
Prikazano bo tudi učinkovito ločevanje privatnih in uradnih zbirk. Sledila bo predstavitev postopka uvažanja 
poljubnih 3D modelov v Kicad ter njihova poravnava s pripadajočimi podnožji. Za konec bo pokazano, kako 
v Freecad ustvarimo 3D model celotnega elektronskega vezja okoli katerega nato lahko izdelamo 3D ohišje.

Projektiranje v aplikaciji Kicad (https://kicad-pcb.org/) poteka na 2-dimenzionalnem (2D) platnu. Aplikacja sicer podpira 3-dimen-
zionalni (3D) predogled elektronskih komponent in elektronskih vezij v formatu s končnico .wrl, vendar pa pretežni del aplikacije 
uporablja (2D) tehnologije. Omenjeni format .wrl uvrščamo v družino mesh, katere format1 vsebujejo podatke o točkah na površini 
telesa. To zadostuje zgolj za prikazovanje telesa. Poleg omenjene družine poznamo tudi družino solid, katere formati2 vsebujejo 
matematične podatke o dimenzijah gradnikov iz katerih je telo narejeno, barvah, fiziki... Ti formati so uporabljeni v 3D modelirnih 
aplikacijah, ki omogočajo ustvarjanje, spreminjanje, animiranje teles...

Kicad ni 3D modelirna aplikacija in ne podpira izvažanja kakršnega koli solid ali mesh formata. To bistveno oteži medstrokovno 
sodelovanje elektronikov in strojnikov. Slednji naj bi v zaključni fazi projektiranja elektronskega vezja pričeli s pripravo pripada-
jočega 3D ohišja, kar pa je mnogo lažje in predvsem hitreje v kolikor elektroniki predložijo 3D solid model elektronskega vezja.

Kicad uporabniki pa za izdelavo solid formata svojega vezja lahko uporabimo 3D modelirno aplikacijo Freecad (https://www.free-
cadweb.org/) in pripadajoči vtičnik Kicad Stepup (https://kicad-pcb.org/external-tools/stepup/).

Članek opisuje zgradbo in učinkovit način vzdrževanja Kicad knjižnic ter vlogo vtičnika Kicad Stepup pri vzdrževanju 3D knjižnic. 
Z omenjenim vtičnikom je prikazan tudi postopek generiranja solid formatov neposredno v aplikaciji Freecad, pri čemer so solid 
formati generirani neposredno iz Kicad datotek s končnico .kicad_pcb, ki definirajo tiskanine (PCB). Procesi so prikazani za ope-
racijski sistem GNU Linux Debian 10 (https://www.debian.org/).

Kicad knjižnice
S spodnjimi ukazi najprej posodobimo podatkovno bazo programskih zbirk, oz. t.i. repozitorijev in nato namestimo Kicad 5.0.2. 
oz. stabilno različico aplikacije.

$ sudo apt update
$ sudo apt install kicad

Za namestitev razvojne različice Kicad 5.1.63, namesto zgornjih ukazov izvedemo spodnje ukaze.

$ sudo bash -c \
"echo deb http://ftp.debian.org/debian/ buster-backports main contrib non-free \
>> /etc/apt/sources.list"
$ sudo apt update
$ sudo apt install -t buster-backports kicad

Kicad vse svoje knjižnice namesti v sistemsko mapo /usr/share/kicad v lasti sistemskega uporabnika root. To lahko preverimo s 
spodnjim ukazom. Uporabnik4 na tej lokaciji nima pravic urejanja s čimer avtorji aplikacije Kicad uporabnikom preprečijo spremi-
njanje prednameščenih knjižnic.

1 V družino mesh spada tudi format s končnico .stl.
2 V družino solid spadajo formati s končnicami .step, .iges, .sat...
3 V prispevku bomo uporabljali Kicad 5.1.6, ki ima integriran iskalnik knjižnic in simbolov na levi strani urejevalnika 
 simbolnih knjižnic, slika 4 (a), in urejevalnika knjižnic s podnožji, slika 9 (a).
4 V kontekstu članka bo uporabnik vedno ziga.

mailto:ziga@pistam.com
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$ ls -l /usr/share/kicad/
total 40
drwxr-xr-x  17 root root  4096 Dec 19 08:36 demos
drwxr-xr-x   2 root root 20480 Dec 19 08:36 library
drwxr-xr-x 115 root root  4096 Dec 19 08:36 modules
drwxr-xr-x   3 root root  4096 May 20 17:21 plugins
drwxr-xr-x   4 root root  4096 Feb 14 10:59 scripting
drwxr-xr-x  19 root root  4096 May 20 17:20 template

Prednameščene knjižnice ne zadoščajo profesionalnemu delu in ker jih ne moremo urejati, jih pustimo nedotaknjene. Uporabljali 
bomo lastne knjižnice, ki jih bomo vzdrževali znotraj uporabniške domače mape5. Tu ima uporabnik vse pravice za branje in pisa-
nje, kar mu bo omogočalo dolgoročno vzdrževanje knjižnic.

Vzdrževanje najnovejše različice uradnih knjižnic
Kicad vsebuje tri odprtokodne uradne knjižnice, ki jih razvijajo na spletnem portalu Github (https://github.com/KiCad/). Najnovej-
še knjižnice se trenutno imenujejo:
symbols (https://github.com/KiCad/kicad-symbols)
• Knjižnica vsebuje .lib izvorne datoteke, ki definirajo 2D geometrijo simbolov elektronskih komponent in tvorijo par z izvornimi datote-

kami .dcm. Slednje definirajo lego in obliko dopolnilnega teksta na simbolu. En par datotek lahko opisuje enega ali stotine simbolov.
footprints (https://github.com/KiCad/kicad-footprints)
• Knjižnica vsebuje mape s končnico .preety, znotraj katerih se lahko nahaja stotine izvornih datotek s končnico .kicad_mod, izmed 

katerih vsaka definira 2D geometrijo natančno enega podnožja na površini PCB.
packages3D (https://github.com/KiCad/kicad-packages3D)
• Knjižnica vsebuje mape s končnico .3dshapes, znotraj katerih se nahajajo izvorne datoteke .wrl, ki omogočajo 3D predogled 

elektronskih komponent v Kicad in izvorne datoteke .step, ki omogočajo urejanje elektronskih komponent v Freecad. Vsaka ele-
ktronska komponenta potrebuje obe datoteki.

Gre za najnovejše knjižnice, ki imajo zaradi nedavnih sprememb v filozofiji organizacije popolnoma drugačna imena kot starejše 
prednameščene knjižnice v mapi /usr/share/kicad. V omenjeni mapi poleg tega ni 3D modelov elektronskih komponent, ki pa so 
prisotne v najnovejših knjižnicah.

Najnovejše knjižnice bomo s portala Github prenesli kar preko konzole. Najprej ustvarimo mapo /home/ziga/Dropbox/workspa-
ce/racunalnistvo/programi/kicad/library-git6 in se premaknemo vanjo. Nato namestimo paket git (https://git-scm.com/) in tako 
pridobimo istoimensko konzolno aplikacijo. Slednjo uporabimo za prenos knjižnic s spleta v ravnokar ustvarjeno mapo. Po zaklju-
čenem prenosu preverimo vsebino trenutne mape.

$ mkdir /home/ziga/Dropbox/workspace/racunalnistvo/programi/kicad/library-git/
$ cd /home/ziga/Dropbox/workspace/racunalnistvo/programi/kicad/library-git/
$ sudo apt install git
$ git clone https://github.com/KiCad/kicad-symbols
$ git clone https://github.com/KiCad/kicad-footprints
$ git clone https://github.com/KiCad/kicad-packages3D
$ ls
kicad-symbols kicad-footprints kicad-packages3D

Ukaz git clone je na spletnih povezavah našel oddaljene repozitorije7 najnovejših knjižnic. Vsebino repozitorijev je nato prenesel v 
eno izmed podmap kicad-symbols, kicad-footprints oziroma kicad-packages3D. Pod vsebino repozitorijev spadajo tudi sistemske 
mape .git, .gitattributes, .github in .gitignore, ki omogočajo spremljanje zgodovine sprememb v repozitorijih.

$ ls -a ./kicad-packages3D/ | grep git
.git
.gitattributes
.github
.gitignore

5 Domača mapa uporabnika ziga je /home/ziga. Ko je uporabnik vpisan se nanjo lahko sklicuje s simbolom ~.
6 V kolikor uporabljamo aplikacijo Dropbox (https://www.dropbox.com/), lahko mapo library-git tako kot 
 v dokumentiranem primeru naredimo v mapi Dropbox. Tako se bodo naše knjižnice avtomatično sinhronizirale 
 med računalniki, npr. v podjetju.
7 Repozitorij je sinonim za lokacijo, kjer hranimo datoteke. Včasih poleg datotek v repozitorijih hranimo tudi sezname 
 datotek, v primeru git repozitorijev pa tudi zgodovino sprememb na lokaciji.

https://github.com/KiCad/kicad-symbols
https://github.com/KiCad/kicad-footprints
https://github.com/KiCad/kicad-packages3D


59    

Zbornik tretje konference IKTEM 2020 

To je izjemno priročno, saj lahko popravke na knjižnici z ukazom git commit najprej vključimo v lokalni repozitorij nato pa z ukazom 
git push spremembe predlagamo v oddaljeni repozitorij8 ter tako prispevamo k razvoju uradnih knjižnic. Pred tem se moramo z 
ukazom cd premakniti v glavno mapo lokalnega repozitorija, npr. kicad-symbols.

$ cd ./kicad-symbols
$ git commit
$ git push

Obratno lahko preverimo, ali v oddaljenem repozitoriju obstajajo novosti in jih preko spodnjega ukaza prenesemo v lokalni repo-
zitorij9.

$ git pull

Nastavitev uradnih knjižnic v Kicad
Sedaj znamo uporabljati orodje git za pridobivanje in vzdrževanje najnovejših Kicad uradnih knjižnic. Poglejmo si še, kako slednje 
vključimo v aplikacijo Kicad. V glavnem oknu aplikacije Kicad, slika 1 (a), sledimo povezavi Preferences > Configure Paths in odpre 
se okno za nastavitev okoljskih spremenljivk, slika 1 (b).

Izmed šestih prednastavljenih okoljskih spremenljivk nas trenutno zanimajo naslednje tri:
KICAD_SYMBOL_DIR
• Okoljska spremenljivka definira pot do knjižnice s simboli elektronskih komponent. Ker kaže na starejšo uradno knjižnico /usr/

share/kicad/library jo preusmerimo na najnovejšo uradno knjižnico kicad-symbols, ki smo jo z aplikacijo git prenesli v mapo 
library-git.

KISYS3DMOD
• Okoljska spremenljivka definira pot do knjižnice s 3D modeli elektronskih komponent. Na začetku kaže na neobstoječo mapo 

/usr/share/kicad/modules/packages3d, zaradi česar Kicad ne najde 3D modelov elektronskih komponent. Trditev preverimo 
tako, da v glavnem oknu aplikacije Kicad sledimo povezavi File > New > Project in v mapi /home/ziga/Dropbox/workspace/racu-
nalnistvo/programi/kicad/projects/ ustvarimo nov projekt 2020-06-02--test. Nato sledimo povezavi Tools > Edit PCB Footprints, 
ki odpre okno za urejanje podnožij. Na levi strani izberemo poljubno podnožje in sledimo povezavi View > 3D Viewer. Ta odpre 
okno za 3D predogled podnožja in elektronske komponente. Podnožje je izrisano, manjka pa izris elektronske komponente, slika 
2 (a). Slednja manjka kljub temu, da je njen prikaz v nastavitvah vklopljen. To preverimo preko povezave Preferences > Display 

8 V oddaljeni repozitorij lahko spremembe predlagamo le v kolikor smo tam na seznamu dovoljenih razvijalcev. 
 V nasprotnem primeru je naš predlog zavrnjen.
9 V kolikor že imamo najnovejšo različico knjižnice, dobimo opozorilo Already up to date.

Slika 1: (a levo) Glavno okno programa Kicad in (b desno) okno za nastavitev okoljskih spremenljivk

Slika 2: (a levo Okno za 3D predogled z mankajočim izrisom elektronske komponente, (b sredinsko) okno za nastavitve 3D 
predogleda in (c desno) uspešno izrisana elektronska komponenta
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Options, slika 2 (b). V kolikor okoljsko spremenljivko preusmerimo na najnovejšo uradno knjižnico kicad-packages3D v mapi 
library-git in ponovno odpremo okno za 3D pregdogled, opazimo, da se izriše tudi elektronska komponenta, slika 2 (c).

KISYSMOD
• Okoljska spremenljivka definira pot do knjižnice s podnožji. Ker kaže na starejšo uradno knjižnico /usr/share/kicad/modules, je 

Kicad v oknu za 3D predogled, slika 2 (a), že od začetka uspešno prikazoval podnožja. Okoljsko spremenljivko kljub temu preu-
smerimo na najnovejšo uradno knjižnico kicad-footprints, ki smo jo z aplikacijo git prenesli v mapo library-git.

Vzdrževanje projektov in privatnih knjižnic
Lokalne repozitorije uradnih knjižnic občasno z ukazom git pull posodobimo na najnovejšo različico pri čemer izničimo naše pred-
hodne spremembe na repozitoriju. Zaradi tega uradnih knjižnic ne spreminjamo!

Uradne knjižnice nam bodo služile kot stacionarni vir komponent oz. datotek, ki jih bomo kopirali v popolnoma ločene privatne 
knjižnice in jih tam spreminjali. Privatnih knjižnic ne bomo vzdrževali na eni centralizirani lokaciji, saj jih želimo vezati na projekte 
in posledično morajo bivati v projektnih mapah. 

Prvi izmed razlogov za to je dejstvo, da projekte včasih želimo arhivirati in poslati npr. stranki, kateri mora projekt delovati. To po-
meni, da moramo projektu priložiti tudi privatne knjižnice in pošiljanje ene velike centralizirane knjižnice ni priročno. Drugi razlog 
je popolnoma ločeno spremljanje zgodovine sprememb za vsako projektno mapo posebej. V projektnih mapah nameravamo z 
ukazom git init vzpostaviti privatne repozitorije, ki bodo spremljali zgodovino sprememb izključno za projekt na katerem trenutno 
delamo in za njegovo privatno knjižnico.

Uporabimo sedaj projekt 2020-06-02--test, ki smo ga naredili v prejšnjem poglavju. Premaknemo se v projektno mapo in ustvarimo 
mapo library znotraj katere naredimo podmape kicad-symbols, kicad-footprints in kicad-packages3D.

$ cd /home/ziga/Dropbox/workspace/racunalnistvo/programi/kicad/ \
projects/2020-06-02--test/
$ mkdir ./library
$ mkdir ./library/kicad-symbols
$ mkdir ./library/kicad-footprints
$ mkdir ./library/kicad-packages3D

V te podmape bomo nato iz uradne knjižnice kopirali komponente oz. datoteke, ki jih bomo uporabljali v projektih. Le tako bodo 
projekti ustrezno arhivirani in odporni pred spremembami uradne knjižnice, istočasno pa bodo prenosljivi.

Preden pričnemo z dodajanjem komponent v podmape, znotraj projektne mape uporabimo ukaz git init, ki ustvari .git sistemsko 
mapo. Slednja od sedaj naprej spremlja dogajanje v projektni mapi. Z ukazom git status lahko kadarkoli preverimo trenutne spre-
membe v projektni mapi.

$ git init
Initialized empty Git repository in 
/home/ziga/Dropbox/workspace/racunalnistvo/programi/kicad/projects/
2020-06-02--test/.git/
$ git status
On branch master
No commits yet
Untracked files:
  (use "git add <file>..." to include in what will be committed)

    2020-06-02--test.kicad_pcb
    2020-06-02--test.pro
    2020-06-02--test.sch

nothing added to commit but untracked files present (use "git add" to track)

Kicad projektne datoteke je git klasificiral v rubriko Untracked Files. V kolikor v mapi ustvarimo novo datoteko README.txt in po-
novno izvršimo ukaz git status, opazimo, da je datoteka ponovno klasificirana v rubriko Untracked files. To pomeni, da je git zaznal 
obstoj vseh datotek znotraj mape a datotek ne obravnava kot del repozitorija in ne sledi njihovim spremembam.

$ touch README.txt && echo "Projektna / privatni repozitorij." >> README.txt
$ git status
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On branch master
No commits yet
Untracked files:
  (use "git add <file>..." to include in what will be committed)

    2020-06-02--test.kicad_pcb
    2020-06-02--test.pro
    2020-06-02--test.sch
    README.txt

nothing added to commit but untracked files present (use "git add" to track)

V kolikor želmo spremljati spremembe na vseh datotekah, uporabimo ukaz git add ., ki vklopi sledenje za vse datoteke in mape v 
trenutni mapi. Ponovno preverjanje stanja razkrije, da so datoteke klasificirane v rubriko Changes to be commited, kar pomeni, da 
git datoteke zazna kot spremembo repozitorija. To pomeni, da so sedaj vključene v repozitorij.

$ git add .
$ git status
On branch master
No commits yet
Changes to be committed:
  (use "git rm --cached <file>..." to unstage)

    new file:   2020-06-02--test.kicad_pcb
    new file:   2020-06-02--test.pro
    new file:   2020-06-02--test.sch
    new file:   README.txt

Preden uveljavimo spremembe, poskrbimo za razpoznavnost našega prispevka. V tekstovnem urejevalniku odpremo datoteko 
~/.gitconfig, datoteka 1, vanjo vnesemo kontaktne podatke in datoteko shranimo. Tako bodo vsi sodelavci vedeli, kdo smo in nas 
v primeru težav lahko kontaktirajo.

[user]
name = Ziga Lausegger
email = ziga@pistam.com
Datoteka 1: ~/.gitconfig.

Poleg tega pri uveljavljanju sprememb z ukazom git commit za parametrom -m podamo komentar v katerem primerno opišemo 
uveljavljene spremembe.

$ git commit -m "Odprtje Kicad projekta in dodajanje README.txt."
[master (root-commit) 7f6f688] Odprtje Kicad projekta in dodajanje README.txt.
 4 files changed, 39 insertions(+)

 create mode 100644 2020-06-02--test.kicad_pcb
 create mode 100644 2020-06-02--test.pro
 create mode 100644 2020-06-02--test.sch
 create mode 100644 README.txt

V kolikor želimo izpisati zgodovino projektnih sprememb uporabimo ukaz git status. Postopek, ki smo ga opisali v tem poglavju, 
ponovimo ob odprtju vsakega novega projekta.

$ git log
commit 7f6f6887ecfb5e89cc7e2c2b545297d79cfcd8d4 (HEAD -> master)
Author: Ziga Lausegger <ziga@pistam.com>
Date:   Tue Jun 2 13:39:58 2020 +0200

    Odprtje Kicad projekta in dodajanje README.txt.
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Nastavitev projektov in privatnih knjižnic v Kicad
Privatne knjižnice simbolov
Projektna mapa je sedaj uspešno inicializirana kot lokalni git repozitorij, ki beleži zgodovino sprememb. Poglejmo si sedaj, kako 
komponente prenesemo iz uradne knjižnice simbolov v privatno knjižnico simbolov in nastavitve, potrebne da Kicad ob odprtju 
projekta najde tudi privatne knjižnice projekta.

Kicad v projektu 2020-06-02--test nemudoma zazna mapo library in podmape kicad-symbols, kicad-footprints in kicad-package-
s3D, ne prikaže pa sistemske mape .git10, slika 3 (a).

Ustvarimo sedaj privatno knjižnico simbolov. V glavnem oknu aplikacije Kicad sledimo povezavi Tools > Edit Schematic Symbols 
in odpre se urejevalnik simbolnih knjižnic, slika 4 (a), v katerem sledimo povezavi File > New Library.... Slednja odpre iskalnik, slika 
4 (b), kjer se premaknemo v projektno podmapo kicad-libraries, vnesemo ime knjižnice symbols.lib in pritisnemo Save. Preden 
Kicad dejansko ustvari knjižnico, moramo izbrati še tabelo v katero bo shranjena povezava do simbolne knjižnice, slika 3 (b).

Izbiramo lahko med tabelama Global ali Project. V obeh primerih se povezava do knjižnice shrani v tabelo sym-lib-table. V primeru 
Global se sym-lib-table shrani v sistemsko mapo našega operacijskega sistema /home/ziga/.config/kicad.

$ ls -l /home/ziga/.config/kicad/
total 96
drwxr-xr-x 2 ziga ziga  4096 Feb 10 11:54 3d
-rw-r--r-- 1 ziga ziga  3400 May 26 20:16 cvpcb
-rw-r--r-- 1 ziga ziga  7519 Jun  2 20:39 eeschema
-rw-r--r-- 1 ziga ziga  2783 Jun  2 14:49 Eeschema.hotkeys
-rw-r--r-- 1 ziga ziga 15546 Dec 21 12:12 fp-lib-table

10  Kicad v glavnem oknu ne prikazuje map in datotek, ki so predznačene s piko. V kolikor bi mapo library želeli skriti, 
 jo trenutno še lahko preimenujemo v .library.

Slika 3: (a levo) Glavno okno programa Kicad zazna projektne podmape in (b desno) okno namenjeno izbiri tabele za shranjevanje 
povezav do knjižnic

Slika 4: (a levo) Urejevalnik simbolnih knjižnic in (b desno) iskalnik
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-rw-r--r-- 1 ziga ziga  1834 Jun  2 20:39 kicad
-rw-r--r-- 1 ziga ziga   907 Jun  2 20:39 kicad_common
-rw-r--r-- 1 ziga ziga 15308 Jun  2 20:17 pcbnew
-rw-r--r-- 1 ziga ziga  6547 Jun  1 11:51 PcbNew.hotkeys
-rw-r--r-- 1 ziga ziga 24735 Jun  2 20:34 sym-lib-table

To lahko potrdimo tudi v urejevalniku simbolnih knjižnic, slika 4 (a), kjer v glavnem meniju sledimo povezavi Preferences > Manage 
Symbol Libraries.... Odpre se urejevalnik povezav do simbolnih knjižnic, slika 5, kjer na vrhu v zavihku Global Libraries razberemo 
lokacijo tabele oz. /home/ziga/.config/kicad/sym-lib-table. Spodaj je tabelarični prikaz vsebine omenjene tabele iz katere razbe-
remo, da je povezava do knjižnice symbols.lib uvrščena na konec tabele sym-lib-table.

Mi bomo v oknu namenjenemu izbiri tabele za shranjevanje povezav do knjižnic, slika 3 (b), izbrali Project. V tem primeru se bo 
tabela sym-fp-lib shranila v projektno mapo. /home/ziga/Dropbox/workspace/racunalnistvo/programi/kicad/projects/2020-06-
02--test/.

$ ls -la /home/ziga/Dropbox/workspace/racunalnistvo/programi/ \
kicad/projects/2020-06-02--test
total 2888
drwxr-xr-x  4 ziga ziga    4096 Jun  2 15:42 .
drwxr-xr-x 15 ziga ziga    4096 Jun  2 20:18 ..
-rw-r--r--  1 ziga ziga      51 Jun  2 10:16 2020-06-02--test.kicad_pcb
-rw-r--r--  1 ziga ziga     688 Jun  2 10:16 2020-06-02--test.pro
-rw-r--r--  1 ziga ziga     461 Jun  2 14:59 2020-06-02--test.sch
drwxr-xr-x  8 ziga ziga    4096 Jun  2 15:10 .git
drwxr-xr-x  5 ziga ziga    4096 Jun  2 13:31 library
-rw-r--r--  1 ziga ziga      41 Jun  2 13:32 README.txt
-rw-r--r--  1 ziga ziga     126 Jun  2 15:03 sym-lib-table

Slika 5: (a) Urejevalnik povezav do simbolnih knjižnic v kolikor izberemo tip tabele Global

Slika 6: Urejevalnik povezav do simbolnih knjižnic v kolikor izberemo tip tabele Project
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To potrdimo v urejevalniku povezav do knjižnic, slika 6, kjer v zavihku Project Speciffic Libraries na vrhu razberemo lokacijo pro-
jektne tabele oz. /home/ziga/Dropbox/workspace/racunalnistvo/programi/kicad/projects/2020-06-02--test/sym-lib-table. Iz spo-
dnjega tabelaričnega prikaza pa razberemo, da je povezava do knjižnice symbols.lib edina v tabeli sym-lib-table.

Ne glede na izbrano tabelo Project ali Global, slika 3 (b), je v tabeli sym-lib-table povezava do knjižnice symbols.lib podana preko 
relativne povezave ${KIPRJMOD}/library/kicad/kicad-symbols/symbols.lib v kateri okoljska spremenljivka KIPRJMOD postane 
projektna mapa trenutnega projekta. 
 
Kljub temu, da je v obeh primerih knjižnica symbols.lib shranjena v projektni mapi pa v primeru tabele Global projektna mapa ni 
prenosljiva, ker tabela sym-lib-table ni shranjena v projektni mapi. V kolikor tako projektno mapo arhivirali in poslali npr. stranki, 
slednji projekt ne bi deloval, ker ne bi našel tabele sym-lib-table posledično pa knjižnic11. 
 
Ravno zato smo pri ustvarjanju knjižnice symbols.lib izbrali tabelo Project. Tako smo poskrbeli, da je tabela sys-lib-table shranje-
na v projektni mapi. V ustvarjeno privatno knjižnico symbols.lib sedaj lahko skopiramo komponento iz uradne knjižnice. Najprej 
v urejevalniku simbolnih knjižnic na levi poiščemo željeni simbol, slednjega desno kliknemo in izberemo Copy, slika 7 (a). Nato 
poiščemo knjižnico symbols.lib, jo desno kliknemo in izberemo Paste Symbol, slika 7 (b). Simbol je sedaj del privatne knjižnice 
symbols.lib, slika 7 (c), in ga lahko po želji spreminjamo. Za konec preko povezave File > Save All shranimo simbol in knjižnico.  
  
V knjižnici library.lib pa lahko ustvarimo tudi popolnoma nov simbol. To storimo tako, da na levi strani v urejevalniku simbolnih 
knjižnic najdemo knjižnico symbols.lib, jo desno kliknemo in izberemo možnost New Symbol..., slika 8 (a). Nato simbolu v novem 
pojavnem oknu določimo ime, npr. symbol--001 in na dnu kliknemo OK, slika 8 (b). Simbol je tako ustvarjen, kar je razvidno na levi 

11 Zaradi tega razvojniki, ki uporabljajo tabele Global, knjižnic ne hranijo ločeno po projektnih mapah. V tem primeru 
 knjižnice hranijo na centralizirani lokaciji, npr. strežniku znotraj podjetja. Ker knjižnice niso razpršene, se komponente 
 knjižnice ne podvajajo, so pa projekti težko prenosljivi in imajo manj jasno zgodovino sprememb saj beležijo spremembe
 komponent knjižnice, ki jih sami mogoče v projektu sploh ne uporabljamo.

Slika 7: (a levo zg.) Iskanje simbola v uradnih simbolnih knjižnicah, (b desno) kopiranje simbola iz uradnih simbolnih knjižnic in 
vnos simbola v privatno simbolno knjižnico
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strani urejevalnika simbolnih knjižnic, slika 8 (c). Sedaj nam preostane le še urejanje simbola skladno z našimi željami in shranje-
vanje napredka preko povezave File > Save All. 

Privatne knjižnice podnožij
Sedaj razumemo, kako preko Kicad upravljati s privatnimi simbolnimi knjižnicami. Upravljanje s privatnimi knjižnicami podnožij je 
precej podobno. Za ustvarjanje svoje prve privatne knjižnice s podnožji v glavnem oknu aplikacije Kicad sledimo povezavi Tools > 
Edit PCB Footprints. Odpre se urejevalnik knjižnic s podnožji, slika 9 (a), v katerem sledimo povezavi File > New Library.... Slednja 

odpre iskalnik, slika 9 (b), kjer se premaknemo v projektno podmapo kicad-footprints, vnesemo ime knjižnice footprints.preety in 
pritisnemo Save. Preden Kicad dejansko ustvari knjižnico, moramo izbrati še tabelo v katero bo shranjena povezava do knjižnice 
s podnožji, slika 3 (b).

Slika 8: (a levo) Ustvarjanje popolnoma novega simbola v privatni simbolni knjižnici, (b desno) določanje njegovega imena in (c 
levo spodaj) viden obstoj simbola znotraj knjižnice na levi strani urejevalnika simbolnih knjižnic

Slika 9: (a levo) Urejevalnik knjižnic s podnožji in (b desno) iskalnik
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Tako kot v primeru privatne simbolne knjižnice lahko izbiramo med tabelama Global ali Project, vendar pa se pri ustvarjanju priva-
tne knjižnice s podnožji, povezava do knjižnice shrani v tabelo fp-lib-table namesto v sym-lib-table. 
 
V primeru tabele Global se fp-lib-table shrani kot /home/ziga/.config/kicad/fp-lib-table, v primeru tabele Project pa v projektno 
mapo kot /home/ziga/Dropbox/workspace/racunalnistvo/programi/kicad/projects/2020-06-02--test/fp-lib-table.

Zgoraj zapisano lahko preverimo po že opisanem postopku. V urejevalniku knjižnic s podnožji, slika 9 (a), sledimo povezavi Prefe-
rences > Manage Footprint Libraries.... Odpre se urejevalnik povezav do knjižnic s podnožji. 
 
V kolikor bi uporabili tabelo Global, lahko pod zavihkom Global Libraries na vrhu razberemo lokacijo tabele oz. /home/ziga/.con-
fig/kicad/fp-lib-table, slika 10 (a). Zaradi opisanih razlogov pa raje izberemo tabelo Project za katero podatke najdemo pod zavih-
kom Project Speciffic Libraries. Na vrhu razberemo lokacijo tabele oz. /home/ziga/Dropbox/workspace/racunalnistvo/programi/
kicad/projects/2020-06-02--test/fp-lib-table, slika 10 (b).

V ustvarjeno privatno knjižnico footprints.preety sedaj lahko dodamo novo komponento. V urejevalniku knjižnic s podnožij na levi 
strani najdemo knjižnico footprints.preety, jo desno kliknemo in izberemo možnost New Footprint..., slika 11 (a). Nato podnožju 
v novem pojavnem oknu določimo ime, npr. footprint--001 in na dnu kliknemo OK, slika 11 (b). Podnožje je tako ustvarjeno, kar je 
razvidno na levi strani urejevalnika knjižnic s podnožji, slika 11 (c). Sedaj nam preostane le še urejanje podnožja skladno z našimi 
željami in shranjevanje napredka preko povezave File > Save All.

Slika 10: (a levo) Urejevalnik povezav do knjižnic s podnožji v primeru tabele Global in (b desno) v primeru tabele Project

Slika 11 : (a levo) Ustvarjanje popolnoma novega podnožja v privatni knjižnici s podnožji, (b desno) določanje njegovega imena in 
(c desno spodaj) viden obstoj podnožja znotraj knjižnice na levi strani urejevalnika knjižnic s podnožji
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Za kopanje komponente iz uradne knjižnice v privatno knjižnico footprints.preety najprej v urejevalniku knjižnic s podnožji na levi 
poiščemo željeno podnožje, slednjega desno kliknemo in izberemo Copy, slika 12 (a). Nato poiščemo knjižnico footprints.preety, 
jo desno kliknemo in izberemo Paste Footprint, slika 12 (b). Podnožje je sedaj del privatne knjižnice footprints.preety, slika 12 (c), 
in ga lahko po želji spreminjamo. Za konec preko povezave File > Save All shranimo podnožje in knjižnico.
 
Privatne knjižnice 3D modelov
Vsako podnožje ima v svojih nastavitvah shranjeno povezavo do 3D mo-
dela elektronske komponente, ki bo prispajkan na podnožje. Poglejmo si 
to na primeru končanega podnožja, ki smo ga ravnokar uvozili v privatno 
knjižnico footprints.preety. Na levi strani urejevalnika knjižnic s podnožji 
lociramo privatno knjižnico footprints.preety in znotraj nje dvokliknemo 
nazadnje dodano podnožje. V kolikor je podnožje uspešno aktivirano se 
njegovo ime obarva. Nato sledimo povezavi Edit > Footprint Properti-
es... in odpre se nam okno z nastavitvami trenutno aktivnega podnožja. 
Premaknemo se pod zavihek 3D Settings, kjer najdemo povezavo do 3D 
modela s končnico .wrl12, slika 13.
 
Relativna povezava do 3D modela s končnico .wrl vsebuje okoljsko 
spremenljivko KISYS3DMOD, ki smo jo v oknu za nastavitev okoljskih 
spremenljivk, slika 1 (b), nastavili na najnovejšo knjižnico 3D modelov 
elektronskih komponent /home/ziga/Dropbox/workspace/racunal-
nistvo/programi/kicad/library-git/kicad-packages3D, ki ni locirana znot-
raj projektne mape.
 
Posledično projekt ni prenosljiv. V kolikor bi projektno mapo v trenutnem stanju poslali npr. stranki, slednja skoraj zagotovo v 
Kicad nima isto nastavljene okoljske spremenljivke KISYS3DMOD in zaradi tega projekt tam ne bi našel 3D modelov elektronskih 

12 Kicad lahko prikazuje le mesh formate s končnico .wrl. Zaradi tega moramo solid formate s končnico, npr. .step 
 pred uvažanjem v Kicad pretvoriti v format .wrl. Kar omogoča Freecad vtičnik Kicad Stepup.

Slika 12: (a levo) Iskanje podnožja v uradnih knjižnicah s podnožji, (b desno) kopiranje podnožja iz uradnih knjižnic s podnožji in 
(c) desno spodaj vnos podnožja v privatno knjižnico s podnožji

Slika 13: Zavihek z nastavitvami 3D modela elektronske 
komponente za izbrano podnožje
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komponent. Poleg tega nimamo zagotovila, da je stranka s 
spletnega portala Github prenesla najnovejše knjižnice, med-
tem ko prednastavljene knjižnice na lokaciji /usr/share/kicad 
nimajo 3D modelov elektronskih komponent, poglavje »Nasta-
vitev uradnih knjižnic v Kicad«.
 
Da bi dosegli prenosljivost projekta, moramo 3D modele ele-
ktronskih komponent za izbrana podnožja najprej prenesti iz 
uradne knjižnice /home/ziga/Dropbox/workspace/racunal-
nistvo/programi/kicad/library-git/kicad-packages3D v podma-
po packages3D.3dshapes}13. Slednjo predhodno ustvarimo v 
privatni knjižnic elektronskih komponent kicad-packages3D, 
ki se nahaja v projektni mapi. Za vsak 3D model elektronske 
komponente moramo prenesti datoteki s končnicama .wrl in 
.step14.
  
$ cd \
/home/ziga/Dropbox/workspace/racunalnistvo/programi/kicad/projects/ \
2020-06-02--test/
$ mkdir ./library/kicad-packages3D/packages3D.3dshapes
$ cp \
/home/ziga/Dropbox/workspace/racunalnistvo/programi/kicad/library-git/ \
kicad-packages3D/Package_SO.3dshapes/SOIC-8_3.9x4.9mm_P1.27mm.{wrl,step} \
./library/kicad-packages3D/packages3D.3dshapes

  
Nato pod 3D nastavitvami izbranega podnožja, slika 13, uredimo povezavo do 3D modela s končnico .wrl. Pri tem namesto 
okoljske spremenljivke KISYS3DMOD uporabimo KIPRJMOD. Slednja vedno kaže na mapo trenutnega projekta in bo zato delovala 
tudi stranki. V kolikor je povezava pravilno nastavljena, pod 3D nastavitvami izbranega podnožja dobimo uspešen izris 3D modela 
elektronske komponente za izbrano podnožje. V našem primeru ${KIPRJMOD}/library/kicad-packages3D/packages3D.3dsha-
pes/SOIC-8_3.9x4.9mm_P1.27mm.wrl uspešno izriše 3D model, slika 14.

Spreminjanje privatnih knjižnic 3D modelov elektronskih komponent
Sedaj znamo upravljati z uradnimi in privatnimi knjižnicami simbolov, podnožij in 3D modelov elektronskih komponent. Uradne 
knjižnice, od koder kopiramo datoteke v privatne knjižnice znotraj projektne mape, vsebujejo izjemno veliko simbolov, podnožij in 
3D modelov elektronskih komponent. Kljub temu se je nemogoče izogniti situaciji, ko v privatno knjižnico projekta želimo vključiti 
elektronske komponente, ki so drugačne od standardnih elektronskih komponent v uradni knjižnici.
 
V primeru simbolov to ni problem, saj Kicad vključuje urejevalnik simbolnih knjižnic, slika 4 (a), in urejevalnik knjižnic s podnožji, 
slika 9 (a), v katerih lahko uredimo kateri koli simbol ali podnožje.
 
Težava se pojavi, ko želimo spremeniti 3D model elektronske komponente za katero koli izbrano podnožje. Kicad podpira izključno 
izris mesh formatov s končnico .wrl, ne podpira pa urejanja solid formatov, npr. tistih s končnico .step. Za urejanje 3D datotek s 
knčnico .step bomo uporabljali aplikacijo Freecad in vtičnik Kicad Stepup. 
 
Za začetek s spodnjim ukazom namestimo aplikacijo Freecad.

$ sudo apt install freecad
 
Ko je aplikacija Freecad nameščena jo zaženemo in odprla se bo v enem izmed svojih delovnih okolij. Predvidoma v delovnem 
okolju Start, slika 15 (a).

Sedaj je potrebno namestiti vtičnik Kicad Stepup. Sledimo povezavi Tools > Addon Manager in v zavihku Workbenches označimo 
vtičnik kicadStepUpMod. Nato na dnu okna za nameščanje vtičnikov kliknemo Install/update, slika 15 (b). Ko je vtičnik nameščen, 
ugasnemo okno za nameščanje vtičnikov in ponovno zaženemo Freecad.
 
Freecad se bo ponovno odprl v delovnem okolju Start. Opazimo da ob zagonu Freecad v zavihku na dnu aplikacije odpre tudi do-
kument Start Page, katerega zapremo da ne bo motil delovnega procesa.

13  Mape s končnico .3dshapes bodo v prihodnosti omogočale grupiranje 3D modelov v Kicad.
14  Datoteko s končnico .wrl potrebujemo za prikazovanje v Kicad, datoteko s končnico .step pa za urejanje v Freecad.

Slika 14:Uspešno izrisan 3D model elektronske komponente za 
izbrano podnožje pri čemer relativna povezava vsebuje okoljsko 
spremenljivko KIPRJMOD
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Nameščeni vtičnik Kicad Stepup je le eno izmed delovnih okolij aplikacije Freecad. Med delovnimi okolji lahko preklapljamo preko 
povezav View > Workbench, kot npr. View > Workbench > KiCadStepUp. V kolikor sledimo tej povezavi bomo preklopili v delovno 
okolje Kicad Stepup. Tu zaradi preprečevanja zmede najprej izklopimo večino orodnih vrstic. Na povezavi View > Toolbars pustimo 
obkljukano le orodno vrstico Workbench. Nato sledimo povezavi ksu Tools > ksu Tools in prikazala se bo orodna plošča. Slednjo 
postavimo na desni rob aplikacije. Nato v glavnem meniju sledimo povezavi View > Panels > Combo View ter vklopimo še kombi-
nirano ploščo v kateri bomo pod zavihkom 
Model videli strukturo projekta, slika 16. 
 
V Kicad Stepup orodni plošči kliknemo na 
ikono A, slika 16, in v iskalniku označimo 
podnožje SOIC-8_3.9x4.9mm_P1.27mm.
kicad_mod, ki smo ga premaknili v projek-
tno podmapo ./library/kicad-footprints/fo-
otprints.pretty. Nato kliknemo gumb Open 
in podnožje s končnico .kicad_mod uvozi-
mo v aplikacijo Freecad, slika 17 (a). 
 
V kombinirani plošči pod zavihkom Model 
se pojavi struktura podnožja, slika 17 (b), 
ki pa je ne smemo spreminjati! Podnožje 
uporabljamo izključno za pravilno pozicio-
niranje 3D modelov elektronskih elementov 
s končnico .step. V kolikor želimo urejati 
podnožje, to storimo v urejevalniku knjižnic 
s podnožji znotraj Kicad, slika 9 (a).

Slika 15: (a leva) Freecad delovno okolje Start in (b desna) namestitev vtičnika Kicad Stepup

Slika 16: Kicad Stepup delovno okolje s Kicad Stepup orodno ploščo na desnem robu 
in kombinirano ploščo na levem robu aplikacije Freecad

Slika 17: (a levo) Kicad podnožje s končnico .kicad_mod uvoženo v aplikacijo Freecad in (b desno) in struktura podnožja prikazana 
v kombinirani plošči
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Sedaj bomo uvozili 3D model elektronske komponente SOIC-8_3.9x4.9mm_P1.27mm.step, ki smo ga predhodno premaknili v 
projektno podmapo ./library/kicad-packages3D/packages3D.3dshapes/. V Kicad Stepup orodni plošči kliknemo ikono B, slika 16, 
izberemo omenjeni 3D model in pritisnemo Open. 3D model se bo prikazal na podnožju in bo pravilno pozicioniran, slika 18 (a), saj 
so njegovo lego in orientacijo s podnožjem uskladili že razvijalci uradnih Kicad knjižnic.
 
V kolikor bi na podnožje želeli postaviti drugo elektronsko komponento, lahko njen 3D model v Freecad sprojektiramo sami, ali pa 
datoteko s končnico .step poiščemo na spletnih straneh, npr. https://www.3dcon-
tentcentral.com/ ali https://grabcad.com/. 

Primer je 3D model SOIC-8-LDS.step, ki ga s spleta prenesemo v projektno pod-
mapo ./library/kicad-packages3D/packages3D.3dshapes. Slednjega nato po opi-
sanem postopku uvozimo v Freecad. Na podnožju imamo sedaj dva 3D modela 
elektronskih komponent pri čemer novi model ni poravnan s podnožjem. Poleg 
tega opazimo, da je 3D model elektronske komponente iz uradne knjižnice sesta-
vljen iz enega gradnika15, medtem ko je novi model sestavljena iz dveh gradnikov16, 
slika 18 (b). 

V kombinirani plošči pod zavihkom Model levo kliknemo staro elektronsko komponento in jo skrijemo s tipko Space. Da bomo 
lahko pozicionirali 3D model nove komponente, moramo njene gradnike najprej združiti. Držimo tipko Control in z levim miškinim 
gumbom izberemo gradnike, ki jih nameravamo združiti. Nato v Kicad Stepup orodni plošči kliknemo ikono C, slika 19 (a). Gradniki 
se v opisanem primeru združijo v gradnik SOIC-8-LDS002_sp, s katerim bomo delali v nadaljevanju. Vse ostale gradnike z izjemo 
podnožja pa skrijemo, slika 19 (b).

15  3D modeli elektronskih komponent iz uradne knjižnice so vedno sestavljeni le iz enega gradnika.
16  3D modeli elektronskih komponent iz spleta so pogosto sestavljeni iz večih gradnikov.

Slika 18: (a levo) 3D model uvožen iz uradne knjižnice je poravnan s podnožjem, (b desno) medtem ko \acc{3D} model uvožen s 
spleta ni poravnan s podnožjem

Slika 19: (a levo)  Postopek združevanja gradnikov \acc{3D} modela in (b desno) skrivanje nepotrebnih gradnikov

https://www.3dcontentcentral.com/
https://www.3dcontentcentral.com/
https://grabcad.com/
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V kombinirani plošči pod zavihkom 
Model sedaj levo kliknemo SOIC-8-L-
DS002_sp in ga pozicioniramo s po-
močjo D skupine ikon17, slika 16. Pri 
pozicioniranju si pomagamo s standar-
dnimi pogledi, ki so vezani na tipke: 

1 - naris,
2 - tloris,
3 - stranski ris,
4 - 2. naris,
5 - 2. tloris,
6 - 2. stranski ris
0 - izometrična projekcija

Ko je 3D model SOIC-8-LDS002_sp pra-
vilno pozicioniran, ga označimo v kom-
binirani plošči in nato s klikom na ikono 
E pričnemo postopek izvažanja 3D mo-

dela za kasnejši uvoz v Kicad, slika 20. V kolikor ponevednoma označimo več kot en gradnik, se postopek izvažanja ne zažene. 
Namesto tega dobimo opozorilo, slika 21 (a). V kolikor izberemo le en gradnik, postopek izvažanja steče in najprej dobimo poziv 

17  Vrednosti oz. inkremente na levi strani D skupine ikon, lahko nastavimo tudi na negativno vrednost. Zaradi neznanega
  razloga ob kliku na katero koli izmed omenjenih ikon Freecad preklopi v delovno okolje Part, kar razberemo iz orodne
  vrstice Workbench, slika 16. Poleg se bodo odprle dodatne orodne vrstice, ki so del delovnega okolja Part.

Slika 20: Pričetek postopka izvažanja 3D modela za kasnejši uvoz v Kicad

Slika 21: (a) Opozorilo da izvažamo več kot en gradnik, (b) poziv k shranjevanju projekta in (c-g) nastavitve podrobnosti na 
izvoženih modelih - od leve proti desni

Slika 22: (a levo) Kicad Stepup okno s povzetkom izvažanja in (b desno) v Kicad izrisani 3D model elektronskega elementa, ki smo 
ga uredili in izvozili iz Freecad



72

https://iktem.si

k shranjevanju projekta, slika 21 (b). Shranjevanje ni nujno zaradi česar kliknemo OK, nato pa shranjevanje prekinemo s Cancel. 
Zatem dobimo pet vprašanj o nastavitvah podrobnosti na izvoženih modelih, slike 21 (c-g). Tu zadostujejo prednastavljene mož-
nosti, zaradi česar vedno kliknemo OK. Ko je postopek izvažanja zaključen, vtičnik Kicad Stepup prikaže okno s povzetkom po-
stopka izvažanja, slika 22 (a). 

V oknu razberemo, da je vtičnik Kicad Stepup v domačo mapo uporabnika /home/ziga izvozil datoteki SOIC-8-LDS002_sp.wrl in 
SOIC-8-LDS002_sp.step. Prva omogoča 3D izris modela v Kicad, drugo pa potrebujemo v kolikor bomo v prihodnosti želeli še kaj 
spremeniti. Datoteki nato pod imenom, ki odraža prvotno ime s spleta prenešenega 3D modela, premaknemo v ustrezni projektni 
podmapi.

$ cd /home/ziga
$ mv \ 
SOIC-8-LDS002_sp.wrl Dropbox/workspace/racunalnistvo/programi/kicad/projects/ \
2020-06-02--test/library/kicad-packages3D/packages3D.3dshapes/SOIC-8-LDS.wrl \
$ mv \ 
SOIC-8-LDS002_sp.step Dropbox/workspace/racunalnistvo/programi/kicad/ \
projects/2020-06-02--test/library/kicad-packages3D/packages3D.3dshapes/ \
SOIC-8-LDS.step

Kot zadnje dejanje moramo v Kicad odpreti urejevalnik knjižnic s podnožji, slika 9 (a), na levi najti privatno knjižnico footprints.
preety in v njej dvoklikniti podnožje SOIC-8_3.9x4.9mm_P1.27mm. Nato sledimo povezavi Edit > Footprint Properties... in odpre se 
nam okno z nastavitvami trenutno aktivnega podnožja, kjer pod zavihkom 3D Settings s pomočjo okoljske spremenljivke KIPRJ-
MOD podnožje usmerimo na 3D model SOIC-8-LDS.wrl v projektni podmapi  ./library/kicad-packages3D/packages3D.3dshapes 
in izrisal se bo 3D model elektronskega elementa, ki smo ga izvozili iz Freecad, slika 22 (b). Nato kliknemo OK in v urejevalniku 
knjižnic s podnožij shranimo napredek s kombinacijo tipk Control + S.

Slika: 23: (a leva)  Primer narisane električne sheme, (b desna) primer sprojektiranega PCB in (c desna spodaj) primer 3D 
predogleda celotnega PCB s prikazom vseh 3D modelov elektronskih komponent
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Sedaj so vsi elementi našega projekta prenosljivi. Izpostavimo le še to, da se povezava do 3D modela elektronske komponente 
s končnico .wrl shrani neposredno v datoteko s končnico .kicad_mod, ki definira podnožje. To enostavno preverimo s spodnjim 
ukazom, ki vrne 1 v kolikor je v datoteki SOIC-8_3.9x4.9mm_P1.27mm.kicad_mod iskani niz .wrl v nasprotnem primeru pa ukaz 
vrne 0.

$ cd /home/ziga
$ mv \ 
SOIC-8-LDS002_sp.wrl Dropbox/workspace/racunalnistvo/programi/kicad/projects/ \
2020-06-02--test/library/kicad-packages3D/packages3D.3dshapes/SOIC-8-LDS.wrl \
$ mv \ 
SOIC-8-LDS002_sp.step Dropbox/workspace/racunalnistvo/programi/kicad/ \
projects/2020-06-02--test/library/kicad-packages3D/packages3D.3dshapes/ \
SOIC-8-LDS.step

Pridobivanje 3D modela elektronskega vezja
Z upoštevanjem do sedaj opisanih principov, lahko ustvarimo popolnoma prenosljiv Kicad projekt, ki vsebuje poljubne simbole, 
podnožja in 3D elemente. Na podlagi osnovnih gradnikov je nato potrebno najprej narisati električno shemo, slika 23 (a). Nato je 
potrebno na podlagi električne sheme sprojektirati PCB, slika 23 (b), katerega elektronske komponente se morajo prikazati tudi v 
3D predogledu elektronskega vezja, slika 23 (c). Gre za osnovna Kicad znanja, ki jih v članku ne bomo obravnavali.

Uspešen prikaz vseh elektronskih komponent in PCB v 3D prikazovalniku je dober indikator za pravilno zgrajen projekt. V tem 
primeru lahko pričnemo z izdelavo 3D modela celotnega elektronskega vezja. Odpremo aplikacijo Freecad, se premaknemo v 
nameščeno delovno okolje Kicad Stepup in vklopimo Kicad Stepup orodno ploščo, slika 16. Nato v Kicad Stepup orodni plošči kli-
knemo ikono F in v iskalniku izberemo datoteko s končnico .kicad_pcb, ki definira sprojektirani PCB. Vtičnik Kicad Stepup bo nato 
v programu Freecad zgeneriral 3D model celotnega elektronskega vezja, slika 24 (a). Projekt preko povezave File > Save shranimo 
v datoteko s končnico .FCStd.

Na podlagi tega projekta lahko sprojektiramo ohišje neposredno v Freecad, slika 24 (b), ali pa 3D model elektronskega vezja 
izvozimo v drug pro2gram. Izvažanje poteka tako, da najprej v kombinirani plošči pod zavihkom Model obkljukamo vse gradnike 
elektronskega vezja18 in nato sledimo povezavi File > Export. Odprlo se bo okno v katerem izpolnimo rubriko File name in v rubriki 
Files of type izberemo enega izmed podprtih formatov .dwg, .iges, .dwg, .scad, .step, .stl, .wrl... Nato kliknemo Save in izvozimo 
3D model v izbranem formatu.

Ključne besede: Kicad, Freecad, 3D

Akronimi
• 3D - 3-Dimensional, https://en.wikipedia.org/wiki/Three-dimensional_space
• 2D - 2-Dimensional, https://en.wikipedia.org/wiki/Two-dimensional_space
• PCB - Printed circuit board, https://en.wikipedia.org/wiki/Printed_circuit_board

18  Pri tem ne smemo obkljukati map v katerih so gradniki.

Slika 24: (a leva) Kicad Stepup delovno okolje z ustvarjenim 3D modelom celotnega vezja. (b desna) 3D ohišje za pripadajoče 
elektronsko vezje v celoti sprojektirano v Freecad

https://en.wikipedia.org/wiki/Two-dimensional_space
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3D natisnjena Peltonova 
hidroelektrarna za 

demonstracijo fizikalnih 
zakonitosti

Laboratorij za energetiko UM FERI  
Avtorja: Matic Markovič, dr. Primož Sukič

p.sukic@um.si

3D natisnjena hidroelektrarna s Peltonovo turbino je namenjena prikazu fizikalnih zakonitosti proizvodnje 
električne energije. Uporabnik lahko s spremembo višinske razlike in s spreminjanem pretoka vode direktno 
vpliva na proizvodnjo električne energije. BLDC motor je uporabljen kot generator in LED trak kot indikator 
proizvodne moči. Eksperimentalni sistem je odličen pripomoček za razjasnitev osnov pretvorbe energije iz 
potencialne v -> kinetično energijo-> mehansko energijo -> električno energijo.

Hidroelektrarna s pomočjo energije tekoče vode proizvaja ele-
ktrično energijo. Trenutna moč elektrarne je odvisna od padca 
in pretoka vode. Na izdelanem eksperimentalnem modelu sta 
pretok in padec ročno spremenljiva. Pretok vode lahko spremi-
njamo s krogličnim vodnim ventilom, padec pa z vertikalnim 
pomikom rezervoarja z vodo po dvižnem sistemu. To storimo 
s vklopom tristopenjskega stikala za dvig in spust rezervoarja 
z vodo. S pritiskom na stikalo vklopimo DC elektromotor, ki 
preko polžastega reduktorja vrti navpično navojno palico. V 
dno posode z vodo je vgrajena matica M18, katera odvisno od 
smeri vrtenja navojne palice leze skupaj s posodo navzgor ali 
navzdol. DC motor je napajan s H-mostom BTN8982TA, ki je 
krmiljen z Arduino UNO. V spodnjem rezervoarju je vgrajena 
črpalka, ki prečrpa vodo v zgornji rezervoar. 

Trenutno moč hidroelektrarne lahko izračunamo z enačbo:
• skupni izkoristek (seštevek izkoristkov - cevovoda, genera-

torja, turbine)
• gostota vode 
• gravitacijski pospešek 
• prostorninski pretok vode 
• padec 

V modelu je uporabljena Peltonova turbina, ki je primerna 
za hidroelektrarne z manjšimi pretoki ter velikimi padci. 
Na turbino je speljan dovodni cevovod. Konča se s šobo, 
ki usmerja vodni curek okroglega preseka tangencialno na 
lopate gonilnika. Voda udarja ob lopate in oddaja gonilniku 
kinetično energijo. Lopatice gonilnika imajo na sredini nož, 
ki deli lopato na dve simetrični polovici. Curka zdrsneta vsak 
po svoji vdolbini lopate, pri tem pa spremenita smer za sko-
raj 180°, poženeta lopato naprej po obodu izgubita hitrost 
in s tem oddata energijo, ki se pretvori v mehansko. Na os 
turbine je nameščen BLDC motor, ki služi kot generator. Na-
petost na izhodu generatorja preko trifaznega Greatzovega 
mostiča meri Arduino. Glede na amplitudo napetosti MCU 
vklaplja število LED-ik na RGB programirljivem LED traku, ter 
jih barvno prilagaja. 
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Uporabljene komponente:
• Arduino Nano, Uno
• GARTT ML 6011 130KV Brushless motor 

for drones
• DC Motor Control Shield BTN8982TA
• DC motor with worm gear reducer
• AC-DC power supply; Output 12VDC, 8.5A
• AC-DC power supply; Output 5VDC, 5A
• Programmable RGB LED strip ws2813
• Submersible water pump 25W
• Transparent acrylic sheet
• Threaded rod M18
• Stainless steel tube M22
• Ball valve inner diameter 12cm
• Transparent PVC tubes (16mm and 

35mm outer diameter)

Viri:
• Video 1 - model hidroelektrarne

◊ https://www.youtube.com/wa-
tch?v=ZPHTx8UatQw 

• Video 2 - 3D model animacija 
◊ https://www.youtube.com/wa-

tch?v=FOP-1KxFy3g  
• Thingiverse 3D modeli

◊ https ://www.th ing iverse.com/
thing:4374462  

• Github – koda za mcu
◊ https://github.com/MaticMarkovic/

Hydroelectric-power-plant-model

https://www.youtube.com/watch?v=ZPHTx8UatQw
https://www.youtube.com/watch?v=ZPHTx8UatQw
https://www.youtube.com/watch?v=FOP-1KxFy3g
https://www.youtube.com/watch?v=FOP-1KxFy3g
https://www.thingiverse.com/thing:4374462
https://www.thingiverse.com/thing:4374462
https://github.com/MaticMarkovic/Hydroelectric-power-plant-model
https://github.com/MaticMarkovic/Hydroelectric-power-plant-model
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Grozd Pametne tovarne
Gospodarska zbornica Slovenije

Zbornica za elektronsko in elektroindustrijo
mitja.virant@gzs.si

+386 1 5898 303
www-etim.si

Povezovanje potencialov za celovito preobrazbo v smeri Industrije 4.0.

Grozd Pametne tovarne deluje v okviru Zbornice za 
elektronsko in elektroindustrijo na GZS in je del stra-
teškega razvojno inovacijskega partnerstva Tovarne 
prihodnosti (SRIP ToP) katerega cilj je je vzpostaviti 
odprto in prijazno okolje za zainteresirane predstavni-
ke gospodarstva, raziskovalnih organizacij, države ter 
ostalih zainteresiranih na prednostnem področju »To-
varne prihodnosti«. 

Grozd Pametne tovarne se osredotoča na področje ce-
lovite in praktične izvedbe preoblikovanja v smeri In-
dustrije 4.0. s ciljem: 
Enotno zasnovani krovni procesi s točno določenimi 
stičnimi in kontrolnimi točkami, ki bodo omogočali digitalizacijo najbolj pomembnih procesov podjetja in njihovo povezavo s podpornimi 
procesi ter procesi poslovnih partnerjev.
Uporaba najbolj sodobnih in optimalnih tehnologij tako pri analizi in postavitvi procesov in koncepta pametne tovarne kot pri implementaciji 
procesov.

Občutno zvišanje dodane vrednosti teh procesov.
Vse potrebne informacije in obveščanje o dogodkih najdete na: https://www.gzs.si/pametnetovarne/ 
       
ETIM podpira digitalizacijo tehničnih izdelkov v elektroindustriji, gradbeništvu in HVAC panogi. Omogoča enostavno izmenjavo podatkov, 
ki vam pomaga pri povečanju prodaje in znižanju stroškov.

ETIM predstavlja najhitrejšo pot do digitalizacije 
digitalizacija po ETIMu omogoča standardiziran digitalni popis tehničnih izdelkov. Vsebuje vse bistvene tehnične karakteristike produkta. 
Razlogi za uvedbo standarda ETIM v organizacijo imajo široko oz. večstransko korist - tako za proizvajalca kot tudi za trgovca, saj oba lahko 
te prednosti koristno uporabita za medsebojno poenostavljeno komunikacijo o tehničnih izdelkih in med drugim tudi kot marketinški instru-
ment. Omogoča poenostavljen vstop v mednarodne distribucijske verige.

Podatkovna strategija v okviru ETIMa omogoča lažji nastop na mednarodnih trgih.

Digitalizacija izdelka je popis izdelka, ki omogoča odločitev za nakup brez fizičnega stika z izdelkom in je bistvena za nadaljnji razvoj izdelka pri 
proizvajalcu in pri odnosu s posrednimi ali neposrednimi kupci.

V okviru Gospodarske zbornice Slovenija je bila ustanovljena nacionalna točka ETIM Slovenija z jasnim ciljem, da se v slovenskem gospodar-
stvu dvigne nivo digitalne kulture. Podjetjem želimo sporočiti kakšne so za njih prednosti digitalizacije tehničnih izdelkov in jih vzpodbuditi k 
izvedbi.

Vzpodbuditi želimo tesnejšo in predvsem trajnejšo povezanost med člani. Nadejamo si, da bi s tem lažje zaznali in okrepili sode-
lovanje na poti digitalne transformacije. 

ETIM Slovenija organizira srečanje članov katero bo potekalo v sredo, 24.6.2020 ob 9.00 v dvorani G na GZS, Dimičeva 13, Ljubljana.
Članom ETIM Slovenija nudimo digitalizacijo izdelkov, pregled stopnje digitaliziranosti konkurence, izobraževanje in izmenjavo dobrih praks 
med člani. 

Skupaj lahko preučimo možnosti in opcije izvedbe digitalizacije v vašem podjetju. Potrudili se bomo poiskati ustrezno rešitev za vas. Za po-
drobnosti nas prosim kontaktirajte.

https://www.gzs.si/pametnetovarne/
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Gospodarska zbornica Slovenije
Zbornica za elektronsko in elektroindustrijo
Zbornica za elektronsko in elektroindustrijo deluje v okviru Gospodarske zbornice Slovenije, kjer svojim članom že desetletja nudi podporo 
in promocijo na področju elektronske in elektroindustrije. Glavne 
naloge ZEE so:
• zagotavljanje konkurenčnost elektroindustrije
• zastopanje interesov članov
• tehniška regulativa in standardizacija
• trgovinski sporazumi in carinski ukrepi
• promocija podjetij elektroindustrije doma in v tujini
• sodelovanje z evropskimi industrijskimi združenji 
• izobraževanja
• socialno partnerstvo
• svetovanje glede projektov na nacionalni in EU ravni. 

Zbornica ZEE svoje člane povezuje preko strokovnih srečanj, organi-
zira posvete, izobraževanja, seminarje in sestanke ter deluje kot povezovalni člen med vladnimi resorji ter strateškimi partnerji na EU ravni.  
Svoje člane redno obvešča preko e-novičnika ZEE, ki zajema:
• novice iz aktualne zakonodaje,
• predstavitev aktualnih razpisov,
• predstavitev pomembnih člankov,
• najava dogodkov, izobraževanj,
• povzetek dogodkov,
• predstavitev dosežkov podjetij članic Zbornice elektronske in elektroindustrije,
• predstavitev nagrad.

Za dodatne informacije obiščite https://www.gzs.si/zbornica_elektronske_in_elektroindustrije ali nas kontaktirajte na zee@gzs.si. 

https://www.gzs.si/zbornica_elektronske_in_elektroindustrije
mailto:zee@gzs.si
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Sponzorji

ZLATI sponzor

SREBRNI sponzor

BRONASTI sponzor
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SPONZORJI konference

PARTNERJI konference

MEDIJSKI sponzorji

PARTNERJI iz univerze
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IZ VSEBINE:
• Testi  
• Novice  
• Nasveti  
• Komentarji  
• TEMATSKE ŠTEVILKE

Revija, s katero boste
na tekočem:

ZABAVNA  
ELEKTRONIKA RAČUNALNIŠTVO

NOVE  
TEHNOLOGIJE

APRIL 2020 U CENA: 5,20 EUR

POSEBNA IZDAJA

VELIKANI IZ VSEBINE

 Tiktok, kitajski Instagram

 Zanimivosti iz življenja Billa Gatesa

 5G - telefoniranje v prihodnje

 Kako Microsoft odkriva najnevarnejše hekerje

 Tekma za najboljši kvantni računalnik na svetu

 Zakaj se pralni stroji učijo igrati harfo

SVET
N A J B O L J Š E  I Z  S V E T O V N E G A  T I S K A

ISBN 961-91168-2-8

VELIKI NAČRT 

JEFFA 
BEZOSA

EDWARD 
SNOWDEN, 
INTERVJU

ELON MUSK

KITAJSKA 
VELESILA

KORONAVIRUS:

• Štiri mogoče časovnice

• Dirka za cepivo

• Je bitcoin res  

varni pristan?

• Vpliv na spletne  

zmenkarije in seks
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revija Ventil
Univerza v Ljubljani, Fakulteta za strojništvo, Aškerčeva 6, 1000 Ljubljana
Tel.: 01/ 4771 704, Faks: 01/ 4771 772
E-pošta: ventil@fs.uni-lj.si, Internet: www.revija-ventil.si

Spoštovani!

Ventil je znanstveno-strokovna revija in 
objavlja prispevke, ki obravnavajo razvojno in 
raziskovalno delo na Univerzi, inštitutih in v 
podjetjih s področja fluidne tehnike, avtomati-
zacije in mehatronike. Revija želi seznanjati 
strokovnjake z dosežki slovenskih podjetij, o 
njihovih izdelkih in dogodkih, ki so povezani z 
razvojem in s proizvodnjo na področjih, ki jih 
revija obravnava. Prav tako želi ustvariti pove-
zavo med slovensko industrijo in razvojno in 
raziskovalno sfero ter med slovenskim in sve-
tovnim proizvodnim, razvojnim in strokovnim 
prostorom. Naloga revije je tudi popularizacija 
področij fluidne tehnike, avtomatizacije in 
mehatronike še posebno med mladimi. Skrbi 
tudi za strokovno izrazoslovje na omenjenih 
področjih.

Revija Ventil objavlja prispevke avtorjev 
iz Slovenije in iz tujine, v slovenskem in angle-
škem jeziku. Prispevkom v slovenskem jeziku 
je dodan povzetek v angleščini, prispevki 
v angleščini pa so objavljeni z daljšim povzet-
kom v slovenskem jeziku. Člani znanstveno 
strokovnega sveta so znanstveniki in strokov-
njaki iz Slovenije in tujine. Revijo pošiljamo 
na več naslovov v tujini in imamo izmenjavo z 
drugimi revijami v Evropi. Revija je vodena v 
podatkovni bazi INSPEC.

Štiriindvajsetletno izhajanje revije Ventil 
pomeni, da je v prostoru neprecenljiva za 
razvoj stroke. Uredništvo si skupaj z znantveno 
strokovnim svetom prizadeva za visokokvalite-
tno raven in relevantnost objav, ki bosta v 
prihodnosti vse napore usmerila v to, da bo 
kvalitetna raven še višja. V ta namen vključuje 
v znantveno strokovni svet priznane znanstve-
nike, raziskovalce in strokovnjake, ki s svojim 
znanjem vspodbujajo vsak na svojem področju 
objavljanje rezultatov razvojnega in raziskoval-
nega dela. Uredništvo spremlja razvoj stroke in 
znanstveno raziskovalno delo doma in vtujini 
preko konferenc, delavnic in seminarjev ter z 
izmenjavo tuje periodike.

Revija je priznana v tujini, še posebno na podro-
čju fluidne tehnike, kar želimo doseči tudi na 
področju mehatronike in avtomatizacije. Preko 
objav v reviji se promovirajo dosežki slovenske 
znanosti in industrijske proizvodnje. Revija je 
in bo tudi v prihodnje prostor za predstavljanje 
kvalitetnih razvojnih in raziskovalnih dosežkov 
slovenske industrije in raziskovalne sfere na 
področju fluidne tehnike, avtomatizacije in 
mehatronike.

Uredništvo

I  Strokovni in znanstveni prispevki

I  Iz prakse za prakso

I  Ventil na obisku

I  Novice - zanimivosti

I  Aktualno iz industrije

I  Novosti na trgu

I  Podjetja predstavljajo

I  Ali ste vedeli

I  Dogodki

ISSN 1318 - 7279 Letnik 24
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DA, naročam revijo Računalniške novice (21 številk) 
skupaj z darilom za 1 leto za samo 33,50 €


Več info ali naročila na:

Lepo je prejeti darilo
Prejemajte sveže novice iz sveta računalništva 
vsakih 14 dni v vaš nabiralnik!

Hkrati pa prejmete darilo

USB ključ Apacer 3.1 – 128 GB

Akcija velja do 31. 8. 2020 oz. do razprodaje zalog!

Darilo USB ključ Apacer 3.1 – 128 GB

Poštnina 
plačana

po pogodbi
št.: 1039/1/S

Računalniške novice
Cesta komandanta Staneta 4 A

1215 Medvode

Ime in priimek: 

Naslov: 

Pošta: 

Telefon/GSM: 

E-pošta: 

01 620 88 00narocnine@stromboli.si 

Ob prejemu tega naročila vam bomo poslali ponudbo za plačilo naročnine, ki znaša 
33,50 € in vas vnesli v bazo naročnikov. Po preteku se vam naročnina samodejno 
podaljša za 1 leto, v primeru, da je ne želite podaljšati, jo lahko pisno odjavite.

21 številk samo 33,50 €

USB ključ Apacer 3.1 – 128 GBUSB ključ Apacer 3.1 – 128 GB

Lepo je prejeti darilo



Organizator:

AX elektronika d.o.o.
Špruha 33
1236 Trzin / Slovenija
https://svet-el.si
00386 1 549 14 00

V skupnem sodelovanju z revijama:

Svet elektronike

Svet mehatronike

ISBN 978-961-6680-18-9 (pdf)
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